MODELING THE EFFECTS OF CLIMATE CHANGE FORECASTS
ON STREAMFLOW
IN THE NOOKSACK RIVER BASIN

By

Susan E. Dickerson

Accepted in Partial Completion

Of the Requirements for the Degree

Master of Science

Moheb A. Ghali, Dean of the Graduate School

Advisory Committee

Chair, Dr. Robert Mitchell

Dr. Douglas Clark

Dr. Andrew Bunn
MASTER’S THESIS

In presenting this thesis in partial fulfillment of the requirements for a master’s degree at Western Washington University, I grant to Western Washington University the non-exclusive royalty-free right to archive, reproduce, distribute, and display the thesis in any and all forms, including electronic format, via any digital library mechanisms maintained by WWU.

I represent and warrant this is my original work, and does not infringe or violate any rights of others. I warrant that I have obtained written permissions from the owner of any third party copyrighted material included in these files.

I acknowledge that I retain ownership rights to the copyright of this work, including but not limited to the right to use all or part of this work in future works, such as articles or books.

Library users are granted permission for individual, research and non-commercial reproduction of this work for educational purposes only. Any further digital posting of this document requires specific permission from the author.

Any copying or publication of this thesis for commercial purposes, or for financial gain, is not allowed without my written permission.

Susan E. Dickerson
May 2010
MODELING THE EFFECTS OF CLIMATE CHANGE FORECASTS ON STREAMFLOW IN THE NOOKSACK RIVER BASIN

A Thesis
Presented to
The Faculty of
Western Washington University

In Partial Fulfillment
Of the Requirements for the Degree
Master of Science

by
Susan E. Dickerson
May 2010
Abstract

The Nooksack River has its headwaters in the North Cascade Mountains and drains an approximately 2300 km$^2$ watershed in northwestern Washington State. The timing and magnitude of streamflow in a high relief, snow-dominated drainage basin such as the Nooksack River basin is strongly influenced by temperature and precipitation. Forecasts of future climate made by general circulation models (GCMs) predict increases in temperature and variable changes to precipitation in western Washington, which will affect streamflow, snowpack, and glaciers in the Nooksack River basin. Anticipating the response of the river to climate change is crucial for water resources planning because municipalities, tribes, and industry depend on the river for water use and for fish habitat. I combined modeled climate forecasts and the Distributed-Hydrology-Soil-Vegetation Model (DHSVM) to simulate future changes to timing and magnitude of streamflow in the higher elevations of the Nooksack River, east of the confluence near Deming, Washington. The DHSVM is a physically based, spatially distributed hydrology model that simulates a water and energy balance at the pixel scale of a digital elevation model. I used recent meteorological and landcover data to calibrate and validate the DHSVM. Coarse-resolution GCM forecasts were downscaled to the Nooksack basin following the methods of previous regional studies (e.g., Palmer, 2007) for use as local-scale meteorological input to the calibrated DHSVM.

Simulations of future streamflow and snowpack in the Nooksack River basin predict a range of magnitudes, which reflects the variable predictions of the climate change forecasts and local natural variability. Simulation results forecast increased winter flows, decreased summer flows, decreased snowpack, and a shift in timing of the spring melt peak and maximum snow water equivalent. Modeling results for future peak flow events indicate an increase in both the frequency and magnitudes of floods, but uncertainties are high for modeling the absolute magnitudes of peak flows. These results are consistent with previous regional studies which document that temperature-related effects on precipitation and melting are driving changes to snow-melt dominated basins (e.g., Hamlet et al., 2005; Mote et al., 2005; Mote et al., 2008; Adam et al., 2009).
Acknowledgements

I gratefully acknowledge the funding, data, and assistance provided by a diverse group of organizations and individuals; this research would not have been possible without their generous sharing of resources and information. Funding was provided by the Whatcom County Flood Control Zone District, the Alcoa Foundation, and the Department of Geology at Western Washington University. Paula Cooper at the Whatcom County River and Flood Division provided useful insight and feedback. I acknowledge two modeling groups, the Program for Climate Model Diagnosis and Intercomparison (PCMDI) and the World Climate Research Programme’s (WCRP) Working Group on Coupled Modeling (WGCM), for their roles in making available the WCRP CMIP3 multi-model dataset. Support of this dataset is provided by the Office of Science, U.S. Department of Energy. Daily gridded meteorological data were obtained from the Surface Water Modeling group at the University of Washington from their web site at http://www.hydro.washington.edu/Lettenmaier/Data/gridded/, the development of which is described by Maurer et al. (2002). Snow telemetry data and background on snow water equivalent measurements in the Nooksack River basin were provided by Scott Pattee at the National Resources Conservation Service. Matt Wiley provided invaluable information, scripts, and advice related to his experience working with the Climate Change Technical Committee.

I am grateful for the enthusiastic support of the faculty at the WWU Department of Geology and Huxley School of the Environment who generously gave of their time and expertise to assist me in this research, including Jackie Caplan-Auerbach, Robin Matthews, ...
and Peter Homann. Many useful discussions and meetings with my thesis committee members, Doug Clark and Andy Bunn, helped to hone my work and provide new ideas and direction. Additionally, Andy provided R scripts for assessing modeling accuracy, and spent much time troubleshooting my R code. I especially thank Bob Mitchell, my advisor and committee chair, for the invaluable support, instruction, and mentorship that he provided.
# Table of Contents

Abstract ................................................................................................................................. iv

Acknowledgements ................................................................................................................ v

List of Tables .......................................................................................................................... ix

List of Figures ....................................................................................................................... x

1.0 Introduction ................................................................................................................... 1

2.0 Background .................................................................................................................... 3

2.1 Nooksack River Basin ................................................................................................. 3

2.1.1 Physical Characteristics of the Nooksack River Basin ......................................... 3

2.1.2 Use and Allocation of the Nooksack River ............................................................ 5

2.1.3 Regional Climate ................................................................................................. 6

2.1.4 Streamflow in the Nooksack River ...................................................................... 6

2.2 Hydrologic Modeling ................................................................................................. 8

2.3 Climate Change .......................................................................................................... 9

2.3.1 Global Climate Change ....................................................................................... 9

2.3.2 Climate Change and Water Resources ................................................................. 10

2.3.3 Future Streamflow in Western Washington ......................................................... 13

3.0 Methods ......................................................................................................................... 15

3.1 Scope of Work ............................................................................................................. 15

3.2 DHSVM ..................................................................................................................... 16

3.2.1 DHSVM Setup ..................................................................................................... 16

3.2.2 DHSVM Algorithms ......................................................................................... 18

3.2.3 DHSVM Calibration and Validation ................................................................ 20

3.3 Climate Change Forecasts ......................................................................................... 22

3.3.1 General Circulation Models ............................................................................... 22

3.3.2 GCM–Emissions Scenario Couples ................................................................. 23

3.3.3 GCM Downscaling ......................................................................................... 25

3.4 Hydrologic Modeling ............................................................................................... 30

3.1.1 DHSVM Simulations ....................................................................................... 30

3.1.2 Streamflow and SWE Analysis ....................................................................... 31

3.1.3 Peak Flow Analysis ......................................................................................... 32
List of Tables

Table 1. Calibrated parameters of the DHSVM for the Nooksack River basin. ................... 62
Table 2. Changes (°C) in monthly mean temperature.......................................................... 62
Table 3. Changes (mm) in monthly total precipitation ......................................................... 63
Table 4. Percent change in median seasonal streamflow .................................................... 63
List of Figures

Figure 1. Hillshade map of the Nooksack River watershed.................................................. 64
Figure 2. 2040s change in temperature and precipitation ................................................. 65
Figure 3. Example of an empirical cumulative distribution function .................................. 66
Figure 4. Empirical cumulative distribution functions of April mean temperature from 1950-1999 ................................................................................................................................. 66
Figure 5. Empirical cumulative distribution functions for April mean temperature for 1950-1999 at the Abbotsford station, and for 2035-2065 of the bias-corrected forecast......... 67
Figure 6. The historical distribution of mean temperature is shifted to create the 2050s forecast.................................................................................................................................................... 67
Figure 7. Hydrograph of observed and simulated streamflow at the North Cedarville USGS gauging station for water years (WY) 2006 through 2009............................................................. 68
Figure 8. Hydrograph of observed streamflow at the Ferndale USGS gauging station and simulated streamflow at the Cedarville station for WY 2001 through 2005 .................. 68
Figure 9. Observed and simulated snow water equivalent (SWE) at three SNOTEL stations in the Nooksack basin for WY 2006 through 2009 ........................................................ 69
Figure 10. Observed and simulated SWE at three SNOTEL stations in the Nooksack basin for the length of their observational record .................................................................................. 70
Figure 11. Boxplots of monthly temperature and precipitation values for the Abbotsford station and for the downscaled hindcasts for 1950-1999................................................................. 71
Figure 12. Empirical cumulative distribution functions for monthly mean temperature for the Abbotsford station and the downscaled time series for 1950-1999 ...................... 72
Figure 13. Empirical cumulative distribution functions for total monthly precipitation for the Abbotsford station and for the downscaled time series for 1950-1999 ...................... 73
Figure 14. Boxplots of fifty years of monthly mean temperature......................................... 74
Figure 15. Boxplots of fifty years of monthly mean temperature......................................... 75
Figure 16. Empirical cumulative distribution functions for monthly mean temperature..... 76
Figure 17. Boxplots of fifty years of total monthly precipitation ......................................... 77
Figure 18. Boxplots of fifty years of total monthly precipitation ........................................ 78
Figure 19. Empirical cumulative distribution functions for total monthly precipitation ..... 79
Figure 20. Monthly mean SWE at the Middle Fork SNOTEL station .................................. 80
Figure 21. Monthly mean SWE at the Middle Fork SNOTEL station ................................. 81
Figure 22. Monthly mean SWE at the Wells Creek (North Fork) SNOTEL station ........... 82
Figure 23. Monthly mean SWE at the Wells Creek (North Fork) SNOTEL station .......... 83
Figure 24. Monthly mean SWE at the Elbow Lake (South Fork) SNOTEL station .......... 84
Figure 25. Monthly mean SWE at the Elbow Lake (South Fork) SNOTEL station .......... 85
Figure 26. Monthly median streamflow at the North Cedarville USGS station .......... 86
Figure 27. Boxplots of monthly median streamflow at the North Cedarville USGS station 87
Figure 28. Monthly mean SWE at a glacier-covered pixel at 2005 m elevation .......... 88
Figure 29. A time series of annual peak flows ................................................................. 88
Figure 30. Boxplots of annual peak flows ................................................................. 89
Figure 31. Empirical cumulative distribution functions of annual peak flows .......... 90
Figure 32. Empirical cumulative distribution functions of spring peak flows .......... 91
Figure 33. Frequency of peaks over 30,000, 40,000, and 50,000 cfs ....................... 92
Figure 34. Histograms of peak flows above 30,000 cfs ............................................. 93
Figure 35. Boxplots of monthly mean temperature for 1950-1999 and 1985-2009 at the Abbotsford station, and for the three forecast datasets centered on 2000 ............... 94
Figure 36. Hydrographs of monthly median streamflow with 2001 glacier coverage, and with glacier coverage reclassified as shrub ............................................. 95
Figure 37. Time series of mean SWE at the Middle Fork SNOTEL for the historical simulation (1950-1999) ................................................................. 96
Figure 38. Histogram of peak flows above 30,000 cfs at Ferndale (observed) from 1966-1999, and at Cedarville (simulated) from 1950-1999 .......................................... 96
Figure 39. Top 200 daily flows at Ferndale (observed) from 1966-1999, and at Cedarville (simulated) for the same days ................................................................. 97
1.0 Introduction

The Nooksack River has its headwaters in the North Cascade Mountains and drains an approximately 2300 km² watershed in northwestern Washington State (Figure 1). Located primarily in Whatcom County, Washington, the river provides freshwater for domestic and commercial use, agriculture, salmon and shellfish habitat, and a variety of recreational opportunities. The timing and magnitude of streamflow in a high relief, snow-dominated drainage basin such as the Nooksack River basin is strongly influenced by temperature and precipitation. Climate change forecasts for the Pacific Northwest (PNW) predict changes to both, which could dramatically affect water resources in Whatcom County. An understanding of the probable response of the Nooksack River, including future streamflow and extreme events, under a range of possible climate conditions is critically important for effective water resource planning. The goal of this research is to predict the timing and magnitude of future streamflow in the Nooksack River by using climate change forecasts and the Distributed Hydrology-Soil-Vegetation Model (DHSVM; Wigmosta et al., 1994).

Prediction of future streamflow depends on prediction of future climate, rather than on historical observations of the variability of streamflow. General Circulation Models (GCMs) have been developed by researchers at institutions worldwide to predict changes in global climate under a range of future emissions scenarios. The GCMs provide predictions for the large-scale climate trends of the future, but forecasts of regional climate, including local-scale weather patterns and topographic effects, are required to characterize future streamflow. In order to use data produced by selected GCMs as the input for a regional-scale hydrologic model I used a statistical downscaling process described by Polebitski et al. (2007a) to convert the GCM data from coarse to fine spatial resolution. The methods utilize
the record of historical weather in order to combine the large-scale trends predicted by GCM forecasts with the patterns and time series observed at the local scale. The downscaled forecasts provide the meteorological input and present-day basin characteristics provide the spatial inputs into a hydrologic model (DHSVM), which simulates snowpack and streamflow in the Nooksack River basin under changing climate conditions.

Possible changes to flood risk are of particular concern to the farmers, residents, municipalities, and industries located on the flood plain of the Nooksack River. The magnitude and frequency of peak flows affects land use planning and the design of flood control measures in Whatcom County. As the climate changes, flood risk will be affected by variations in the amount and timing of precipitation, and by increasing temperature. Whereas the main goal of this study is to predict the overall response of the daily and monthly hydrographs to forecasted changes in climate during the next century, analyses of sub-daily peaks provide a sense of how peak flows may change through time.

This study is patterned after the work of the Climate Change Technical Committee (CCTC), associated with the Climate Impacts Group (CIG) at the University of Washington. The CCTC investigated hydrologic impacts of climate change on five river basins in Pierce, King, and Snohomish Counties. The research was funded by a variety of groups interested in the long-term management of water resources (Palmer, 2007b). The methodology of the CCTC for the Regional Water Supply Planning Process was chosen for this study as a means of comparing the Nooksack to other western Washington rivers (e.g., Polebitski, 2007a).
2.0 Background

2.1 Nooksack River Basin

2.1.1 Physical Characteristics of the Nooksack River Basin

The headwaters of the Nooksack River are in the North Cascade Mountains, and the North, Middle, and South forks flow approximately west to their convergence near Deming, WA. The main stem of the river meanders through the lowland until it discharges into Bellingham Bay with an annual mean discharge of 3,000-4,000 cfs (USGS, 2009). There are two distinct provinces of the basin, delineated by topography, geology, and land use: the upland headwaters in the Cascades, and the lowlands west of the confluence. The majority of runoff into the Nooksack River comes from the upland province, whereas the majority of water usage is in the lowland (Bach, 2002). Topography in the upland province is rugged; elevation varies from 300 m to over 3,000 m. The upland province includes Paleozoic and Mesozoic metamorphic rocks of the North Cascade System crisscrossed by thrust faults and strike-slip faults, late Cretaceous through Eocene sandstones, shales, and conglomerates of the Chuckanut Formation, and Quaternary volcanic rocks and glacial deposits. Landslide and lahar deposits overprint the bedrock geology and are an important influence in the geomorphology of the basin (Dragovich et al., 1997). Upland land use primarily includes state and federally managed land and conservation lands. The landscape is heavily forested and includes second growth stands of coniferous and deciduous trees including Douglas Fir (*Pseudotsuga menziesii*), Western Hemlock (*Tsuga heterophylla*), Western Red Cedar (*Thuja plicata*), Red Alder (*Alnus rubra*), and Maple (*Acer*), and dense undergrowth including Salal
(Gaultheria shallon), Devil’s Club (Echinopanax horridum), Huckleberry (Vaccinium), Oregon Grape (Berberis), and ferns. Soils are formed from loess, volcanic ash, colluvium, and slope alluvium derived from weathered bedrock and Quaternary volcanic and glacial deposits, and vary across the basin from shallow to very deep, and from moderately well drained to well drained (Golden, 1992).

The lowland is characterized by low elevation (0-300 m) and low relief. The river meanders through Quaternary glacial sediments including recessional outwashes of the Vashon Glaciation, Vashon till, and recent alluvial deposits. Lowland land use is dominated by agricultural, commercial, and residential use; major agricultural operations include fruit and dairy farms. The lowland province of the basin, west of the USGS stream gauge at North Cedarville, is excluded from this study because the strong influence of agricultural, industrial, and municipal water usage create a challenge to accurately modeling the hydrology of this portion of the basin.

Snowpack and glaciers supported by abundant winter precipitation combined with the high relief of the upland Nooksack basin result in substantial spring and summer snowmelt and/or glacial melt. The headwaters include Mt. Shuksan, Mt. Baker, and the Twin Sisters, with approximately 16 to 40 percent of streamflow derived from snowmelt (Bach, 2002). The North Fork originates from the East Nooksack Glacier on Mount Shuksan and the headwaters of the Middle Fork include the Deming Glacier; the South Fork currently contains no glaciers. During the Pleistocene glacial maximum of the Fraser Glaciation the Cordilleran Ice Sheet covered the Nooksack basin, except for Mt. Baker, Mt. Shuksan, the Twin Sisters, and a few other peaks.
2.1.2 *Use and Allocation of the Nooksack River*

The Nooksack River flows past several municipalities and tribal reservation lands in Whatcom County, including Deming, Everson, Lynden, Ferndale, the Nooksack Reservation, and the Lummi Reservation. Streamflow is allocated for drinking water, irrigation, and industrial processes. Streamflow is also used for recreation and for providing habitat to salmon and shellfish. A 1500 kilowatt hydroelectric plant at Nooksack Falls on the North Fork has been operated by Puget Sound Hydro LLC since 2003 (FERC, 2004). Two salmon hatcheries are operated in the upper Nooksack basin: one operated on Skookum Creek (South Fork) by the Lummi Tribe, and the other operated on Kendall Creek (North Fork) by Washington Department of Fish and Wildlife.

The Washington Watershed Management Act of 1998 provided the framework for local control of watershed planning. As a result, Water Resource Inventory Area No. 1 (WRIA 1), which encompasses the surface and ground water in the Nooksack River basin, was established. Stakeholders include the Nooksack Tribe, Lummi Nation, and Whatcom County municipalities, public utilities, industries, individuals, and farms that depend on the Nooksack River for freshwater fish habitat and domestic, commercial, municipal, industrial, and irrigation uses. The WRIA 1 Watershed Management Project includes assessment, planning, and action related to water quantity, water quality, fish habitat, and instream flows in the Nooksack River (WRIA 1, 2008).

The City of Bellingham operates a diversion pipeline from the Middle Fork of the Nooksack River to Lake Whatcom in order to increase water quantity and quality. Approximately half of the population of Whatcom County, about 80,000 people, rely on Lake Whatcom as a drinking water source. Minimum instream flows for the MF Nooksack
are regulated by the Washington Department of Ecology; diversion to Lake Whatcom may occur only when the minimum instream flow requirement is met (DOE, 1988).

2.1.3 Regional Climate

The Nooksack watershed is characterized by the mild temperatures typical of a maritime climate; fall and winter are characterized by frequent, low intensity precipitation, whereas late spring and summer are relatively dry. Average annual precipitation (1971-2000) ranges from 40 inches in the lowland to over 140 inches at the top of Mount Baker (PRISM, 2008). There is a steep topographic gradient from west to east which creates a negative lapse rate for temperature and a positive lapse rate for precipitation across the basin. As elevation generally increases from west to east, the temperature decreases, allowing for snow to fall in the mountains while rain falls in Bellingham. Conversely, the increase in elevation over the mountains causes an increase in precipitation due to the orographic effect. As moisture-laden air is lifted over the mountains it experiences adiabatic cooling due to the decrease in pressure, causing more precipitation to fall as the air is lifted to higher elevations. Thus, though the climate in the lowland is relatively mild, Mount Baker holds the record for the most annual snowfall recorded in the world at 1,140 inches during the winter of 1998-1999 (Mass, 2008).

2.1.4 Streamflow in the Nooksack River

Streamflow in the Nooksack River is characteristic of a snow-melt dominated basin that lies within a mild, rainy climate at lower elevations. As precipitation increases during the fall and winter, streamflow increases and peaks. Streamflow decreases in late-winter to spring as colder temperatures cause more precipitation to fall as snow and become stored in the snowpack, reducing the area of the basin contributing to runoff. Additionally,
precipitation decreases in mid- to late-spring, reducing runoff. Lower spring flows are followed by a second, lower peak in the hydrograph in late spring or early summer as the snow melts. Streamflow decreases throughout the summer as the snowpack is depleted and precipitation is low. Low summer flows are buffered by melting from glaciers in the North and Middle Fork basins of the Nooksack.

Streamflow in the Nooksack River is monitored by the USGS at five real-time stations: Cascade Creek (North Fork), Wickersham (South Fork), Deming (Middle Fork), North Cedarville (Nooksack River), and Ferndale (Nooksack River). The USDA National Resources Conservation Center operates snow telemetry (SNOTEL) sites that monitor precipitation, snow water equivalent (SWE), and temperature in the watershed in three locations: Middle Fork Nooksack, Wells Creek (North Fork), and Elbow Lake (South Fork).

Bach (2002) quantified the amount of streamflow derived from a glaciated basin (the North Fork) as compared to a similar unglaciated basin (the South Fork) in the Nooksack, by comparing streamflow measured by the USGS at the Glacier station (North Fork) and the Wickersham station (South Fork) to the total flow after the confluence of the forks. Bach estimated that 26.9% of summer streamflow in the Nooksack River is attributable to high elevation snow and glacier melt.

Donnell (2007) used the DHSVM to quantify the glacial melt water component of streamflow in the Middle Fork Nooksack. Estimated late summer glacial melt water contribution based on 2002 glacier conditions and 2006 meteorological data was 8.4 – 26.1%. Donnell also modeled the effect of glacier recession on streamflow, using a linear glacier recession rate and modern climate data, and predicted up to 8.6% decrease in streamflow in the Middle Fork during the next fifty years as a result of glacier shrinkage.
2.2 Hydrologic Modeling

Hydrologic modeling to predict streamflow began in the 1950s and 1960s with spatially lumped models that used a water balance approach and meteorological data averaged over an entire watershed to forecast streamflow (Storck et al., 1998). However, the availability of digital spatial data, such as digital elevation models and soil maps, combined with advancements in computing power, led to the development of spatially distributed hydrology models that simulate rainfall and runoff in individual pixels of a spatially heterogeneous watershed (Storck et al., 1998). The DHSVM is a physically based, spatially distributed hydrology model that was developed at the University of Washington and the Pacific Northwest National Laboratory. The model was originally tested and validated in the Middle Fork Flathead River basin in Montana (Wigmosta et al., 1994).

The model’s explicit representation of spatially variable watershed characteristics has allowed applications to understand hydrologic impacts of land use changes. Storck et al. (1995) investigated the effect of forestry impacts on peak flows in the Snoqualmie River basin and modified the model to simulate flood events in maritime mountainous watersheds. An accurate representation of this PNW basin required a variable time step, with an hourly time step to model flood events and a daily time step during periods of consistent base flow, a precipitation lapse rate, and a two-layer snowpack component. The DHSVM has been used to model the effects of timber harvesting, including change in vegetation cover and addition of roads, on the magnitude of flood events (e.g., Storck et al., 1998; Wigmosta and Perkins, 2001). The DHSVM has recently been applied to partially urbanized watersheds, with representations of impervious surfaces and retention ponds in the model (Cuo et al., 2008).
The DHSVM combines spatially variable watershed characteristics, including elevation, soil type, soil thickness, and vegetation with temporally variable meteorological information such as temperature and precipitation to predict the magnitude and timing of streamflow in the watershed. The DHSVM utilizes the physical relationships in the hydrologic cycle, such as the relationship between temperature and evaporation, to calculate the flux of water and energy in and out of each grid box, or pixel, in a Digital Elevation Model (DEM). Water and energy can be stored in a pixel or can move between adjacent pixels, with direction and rate dependent on topography, soil type, and other factors. Water flows across the surface and through the subsurface, and collects in stream valleys, which translates to the simulated discharge of the stream. Thus, the DHSVM provides a tool for understanding the surface water hydrology in a mountainous watershed given information about past, present, or future spatial characteristics and climate.

The DHSVM is calibrated and validated against historical records of meteorology and measured streamflow in order to use the model as a predictive tool. The small size of each pixel (30-150 m on a side), allows the spatial heterogeneity of the watershed to be represented in the model. Small variations in elevation and topography have an important effect on regional hydrology, as illustrated in the temperature and precipitation lapse rates across the Nooksack basin.

2.3 Climate Change

2.3.1 Global Climate Change

The Earth’s climate is a complex system composed of the interaction of subsystems that include the atmosphere, oceans, biosphere, land surface, and cryosphere. Global
temperature responds to a net change in the energy balance; an energy surplus leads to warming, whereas an energy deficit leads to cooling. The climate system is an inertial system due to the high specific heat of water and the large percentage of the Earth covered by oceans. Therefore it may take decades for the climate system to reach an equilibrium temperature after an energy imbalance occurs. Climate is the statistical average of weather, commonly calculated over a 30-year period. Within a climate, the daily or hourly weather can be extremely variable due to local weather patterns and topography; additionally, the climate system, and average global temperature, varies due to internal and external factors, including pseudo-periodic internal variations such as the El Niño Southern Oscillation (ENSO), the Pacific Decadal Oscillation (PDO), solar variations caused by the periodic Milankovitch cycles, random changes such as volcanic events, and feedbacks to the system.

Evidence indicates that the Earth’s climate is warming. Average global temperature has increased 0.74°C in the last 100 years (1906-2005), sea level has risen 1.8 mm/year from thermal expansion and melting of glaciers, and global ice cover has decreased (IPCC, 2007). Proxy data that are sensitive to changes in climate such as tree rings, pollen, ice cores, and corals, have been used to reconstruct global temperatures during the last several millennia (National Research Council, 2006). Studies of these different proxy data have produced climate reconstructions that show that average global temperature has fluctuated over the last 1,000 years. The modern warming trend, however, departs sharply from the known upper bounds of recent natural variability (National Research Council, 2006).

2.3.2 Climate Change and Water Resources

Three decades of studies on the effects of climate change on water resources indicate that both temperature and precipitation have direct effects on the timing and magnitude of
streamflow. The response of a given stream, however, is highly variable and non-linear based on basin characteristics and local and regional climate (Alexander et al., 2007). Climate-driven effects on streamflow include changes to the ratio of precipitation in the form of rain to snow, amount of total precipitation, timing of snowmelt, and timing in seasonal changes in soil moisture content. An average warming rate of 0.1-0.6°C/decade is projected for the Pacific Northwest (Mote et al., 2005; Alexander et al., 2007). The temperature change is expected to result in higher winter and spring streamflow and an earlier melt season in snowmelt-dominated basins, resulting in decreasing summer flows at the height of water usage demand. Projected changes to rainfall in the Pacific Northwest are variable and modest; most models predict an increase in winter precipitation and a decrease in summer precipitation (Mote et al., 2007).

Investigations on Western river basins have focused on the impact of temperature on the type and amount of precipitation and on the timing of snowmelt. A number of studies have documented the shift of the timing of spring snowmelt to earlier in the year under warming climate conditions (e.g., Lettenmaier and Gan, 1990; Cayan et al., 2001; Regonda et al., 2005; Stewart et al., 2004). Numerous modeling studies on the Sacramento River indicated that changes to the timing and magnitude of runoff as a result of temperature-driven changes to the snow dynamics in the river basin (Gleick and Chalecki, 1999).

Spatially distributed hydrology models have been used to predict the response and to evaluate sensitivity of snowpack and streamflow to different climate conditions. Leung and Wigmosta (1999) used the DHSVM and regionally downscaled GCM forecasts to predict the sensitivity of two Pacific Northwest basins, the American River (coastal) and the Middle Fork Flathead River (continental), to changes in climate under a doubling in atmospheric
CO₂ concentration. The American River responded with a 60% decrease in basin SWE and an early spring melt, whereas the SWE in the Middle Fork Flathead was reduced only by 18% and the timing of spring streamflow remained the same. Their study demonstrated the regional variability of the magnitude of effects of climate change on snowmelt-dominated basins. Mote et al. (2005) documented a decreasing trend in SWE in the Western U.S. from 1925-2000 based on observed data, and argued for a predominantly climatic cause for the trend. The largest relative decreases were in the Pacific Northwest, which pointed to the increased sensitivity of SWE to elevation, and to mean winter temperature. Mote et al. (2008) determined that temperature was the dominant long-term influence on the 15-35% decline of April 1 SWE in the Cascades since the 1950s.

The interaction of changing climate conditions with the type and amount of precipitation also has an important impact on flood risk in Western river basins. The distribution of peak flows, and therefore, flood risk, is variable through time due to natural climate variability such as the ENSO and the PDO (Kiem et al., 2003). Hamlet and Lettenmaier (2007) analyzed the effects of 20th century temperature and precipitation trends and of variability caused by ENSO and the PDO on flood risk in the western U.S. Their findings indicate that flood risk generally increased under warming temperature conditions for intermediate coastal basins where the mean winter temperature ranges from -5 to 5°C, such as the Nooksack basin.

The understanding of the first-order effects of changing climate on water resources is a necessary precursor to an understanding of second-, third- and fourth- order effects, such as changes to hydropower, electricity prices, and national security, respectively (Chalecki and Gleick, 1999). Many studies are focused on the effects of climate change on streamflow in
order to plan for future water resource availability and needs. Milly et al. (2008) asserted that water resource planners can no longer rely on historical records to characterize an unchanging range of weather variability; rather, planners need to consider future water resources based on changing climate scenarios.

2.3.3 Future Streamflow in Western Washington

The Climate Change Technical Committee (CCTC) used downscaled GCM predictions and the DHSVM to model the effects of climate change forecasts on five river basins in King, Pierce, and Snohomish Counties: the Cedar, Green, White, Sultan, and Tolt Rivers. The CCTC was formed as part of the Regional Water Supply Planning Process, a collaborative effort between the Climate Impacts Group (CIG) at the University of Washington, the WA Department of Ecology, public utilities, tribes, and other community groups. The goal of the group was to gather data and tools to assess the impact of climate change on local water resources, and thus to assist in water resource management and planning (Alexander et al., 2007). The CCTC outlined background, methods, and results of their research in a series of eight technical memos and made their results available in a variety of formats to interested groups and individuals (e.g., Polebitski et al., 2007a; http://www.climate.tag.washington.edu/).

Results from the CCTC studies included an overall shift in the hydrographs of each river to an earlier spring melt. Each river showed different changes in the magnitude of streamflow under a range of future climate conditions; the average change in all five rivers was a positive net increase in annual flow, with increasingly negative changes to summer flow and increasingly positive changes to winter flow in the next 75 years (Polebitski et al., 2007c).
The CIG’s Columbia Basin Climate Change Scenarios Project produced a database of climate-impacted hydrologic scenarios using the Variable Infiltration Capacity (VIC) model at a 1/16° resolution (CIG, 2010; www.hydro.washington.edu/2860/report/). The VIC model is a spatially distributed hydrology model that calculates a water balance on the pixel scale. The primary differences between the VIC model and the DHSVM are the coarser spatial resolution of the VIC model and the consequent parameterization of topography and infiltration processes across the larger pixels (Carrasco and Hamlet, 2010; Elsner and Hamlet, 2010). The results from this project include predictions for streamflow, SWE, temperature, soil moisture, and other factors important to the hydrologic cycle for approximately 300 locations in the Columbia River basin and coastal watersheds in the Pacific Northwest. Streamflow in the Nooksack River, simulated at the USGS Ferndale gauge, was included in the project. Predictions for the Nooksack River are similar in trends to the CCTC’s simulations of regional rivers. The results, currently provided in draft form on the project website, provide a basis for comparison with the simulations from this study, though the spatial resolution and some methodologies vary between the two studies.
3.0 Methods

3.1 Scope of Work

This project required six main tasks:

1. Set-up the spatial inputs for the Nooksack River drainage using ArcGIS based tools and convert to formats recognized by the DHSVM (e.g., binary).

2. Collect and process meteorological input data required by the DHSVM, including temperature, precipitation, longwave radiation, shortwave radiation, wind speed, and relative humidity. Additionally, a 30- to 50-year historical time series is required for the downscaling process.

3. Collect and process historical streamflow data for use in model calibration and validation.

4. Establish initial conditions for the basin by running the DHSVM for fifteen months, including water year (WY) 2000 and the first three months of WY 2001. Calibrate the DHSVM to the Nooksack River at North Cedarville using meteorological data from WY 2006 to 2009.

5. Use statistical downscaling techniques to create a local climate change forecast dataset including temperature and precipitation. Process these data to obtain the remaining meteorological input required for the DHSVM (e.g., longwave radiation).

6. Perform hydrologic simulations using the downscaled climate change forecast data as the meteorological input, and assess changes in snowpack and streamflow timing and magnitude as a result of changes in climate and related changes in glacier coverage.
3.2 DHSVM

3.2.1 DHSVM Setup

The DHSVM requires inputs of meteorological data and spatial data in order to simulate the hydrology of the basin (Wigmosta et al., 2002). Meteorological data are required for the time step at which the model is run, ranging from hourly to daily. I used a three-hour time step to capture the sub-daily fluctuations in solar radiation, which are a major control on snowmelt. The GCM-based forecast data are originally modeled at a monthly time step and are disaggregated to daily resolution during the downscaling process. Thus, a three-hour time step captures sub-daily radiative fluxes, but does not overstate the temporal resolution of the downscaled and disaggregated data. Additionally, a three-hour time step provides efficient computation for multiple fifty-year simulations.

Meteorological inputs include temperature (°C), precipitation (m), wind speed (m/s), relative humidity (%), incoming shortwave radiation (W/m²), and incoming longwave radiation (W/m²). Daily meteorological data for calibration, validation, and downscaling are from the Abbotsford A station, in British Columbia, Canada, which was chosen for its long and relatively complete historical record, and its location approximately 27 km northwest of the confluence of the Nooksack River (49.03° N, 122.36° W; NCDIA, 2009). Less than 1% of the daily temperature and precipitation data reported by the Abbotsford station were missing or estimated for the sixty years (1950-2009) used for calibration, validation, and downscaling. For single missing days of data I used the mean of the surrounding values. For multiple missing days of temperature and precipitation data I patched the record with the values recorded at the nearby COOP Clearbrook station if they were available, and, if not, I repeated the previous sequence of values. Comparison of annual precipitation and
temperature values for the Abbotsford station with the Clearbrook station showed similar observations at the two stations. Daily total precipitation values that were recorded as zeroes and flagged as “trace” precipitation were treated as zeroes. Patching and plotting the data to check for continuous and reasonable values was performed in Microsoft Excel.

The observed daily minimum temperature, maximum temperature, and total precipitation values were disaggregated into a 3-hour time step, and used to derive the other required meteorological input values for the DHSVM by running a script written by Matt Wiley (Wiley, personal communication, 2009). I replaced the script-generated wind speed values with 3-hour averages of observed hourly values from the Abbotsford weather station because the script output for wind speed was primarily 2.8 m/s, which is the default. Although the DHSVM is not particularly sensitive to wind speed, I chose to use the observed values because they are available (Wiley, personal communication, 2009); where values were missing I used 2.8 m/s, and where the recorded value was 0.0 m/s I used 0.5 m/s due to a simulation error caused by zero values. I used the same time series of observed wind speed values in all meteorological input files.

Although observed hourly data for some of the meteorological inputs are available from the Abbotsford station, the Clearbrook station, and the SNOTEL stations, I chose to disaggregate daily data from the Abbotsford station and use the script-derived values for calibration and validation in order to be consistent with my downscaled GCM forecast simulations. Due to the monthly temporal resolution of GCM-based forecast data, I needed to use script-derived sub-daily values in experimental simulations; therefore, calibration procedures were designed to mimic the methods I would use for the forecast simulations.
The DHSVM requires six maps as spatial inputs, including elevation, watershed boundary, land cover, soil type, soil depth, and stream network; the spatial inputs are managed in ArcGIS, primarily as raster files. The ArcGIS based set-up process and the sources of data for the spatial inputs are detailed in Appendix A. Elevation data are available as USGS 7.5 minute, 10-meter Digital Elevation Models (DEMs), and provide the base layer of spatial information. Landcover data, including vegetation and glacial coverage, are based on the 2001 National Oceanic and Atmospheric Administration (NOAA) land cover grid, and soil type is derived, in part, from the United States Department of Agriculture State Soil Geographic (STATSGO) database.

Watershed boundaries, soil depth, stream networks, and flow routing are created based on elevation using ArcGIS tools including ArcGIS hydrology modeling tools and Arc Macro Language scripts (Wigmosta et al., 2002). A road network and its associated characteristics is an optional spatial input in the model, which I omitted due to the low density of roads in the upper portion of the basin and the lack of available data. For this study I define the lower extent of the basin at the USGS North Cedarville stream gauge, downstream of the confluence near Deming; west of Deming the natural streamflow is altered by inputs and outputs of water related to municipal, agricultural, and commercial use. The watershed boundary, defined by elevation and by choosing a pour point for the basin, is the shape to which all other spatial data are clipped. All spatial data were re-sampled at 150 meter resolution to be consistent with the CCTC and to provide computational efficiency.

3.2.2 DHSVM Algorithms

At each time step and for each pixel, the model provides simultaneous solutions to water and energy balance equations for seven hydrologic processes: evapotranspiration,
snowpack accumulation and melt, canopy snow interception and release, unsaturated moisture movement, saturated subsurface flow, surface overland flow, and channel flow (Wigmosta et al., 2002). Evapotranspiration is represented through a two layer canopy, with each layer partitioned into a wet and dry percentage; the rate of evaporation and transpiration is calculated based on meteorological factors, vegetation type, and soil type. Snowpack is represented by a surface layer and a pack layer with energy and mass exchanged between the layers. Snow that is intercepted by the canopy is represented by a single layer that exchanges mass and energy with the air and ground below through interception, sublimation, and melt. Vertical movement of water through the unsaturated zone is represented through three soil layers in the model. Water that accumulates on the surface at a rate higher than the user-defined infiltration rate is routed as excess overland flow; water that infiltrates moves into the layer below at a rate described by Darcy’s Law, or is removed through transpiration based on the type of vegetation in the rooting zone. Water that reaches the water table is routed laterally as subsurface flow. The direction and rate of saturated subsurface flow is determined via hydraulic gradients and hydraulic conductivities. Overland flow in the model includes saturation excess runoff when precipitation falls on a saturated soil surface, and return flow when the water table rises to the ground surface. Channel flow is routed through a linear storage routing algorithm in which outflow from the channel is linearly related to storage in the channel (Wigmosta et al., 2002). Point values of temperature and precipitation that were recorded or simulated for a specific meteorological station are distributed to each pixel in the model through observed lapse rates, interpolation methods, or through gridded temperature and precipitation maps, such as the PRISM maps developed by NRCS National Water and Climate Center (NWCC) and Oregon State University (OSU). The Abbotsford
station is located at an elevation of 59 m whereas the elevation of the upper Nooksack basin ranges from 36 to 3,275 m.

3.2.3 DHSVM Calibration and Validation

The DHSVM is calibrated to a watershed by comparing simulated streamflow and SWE to measured values for years in which there are observed streamflow, SWE, and meteorological data. During calibration, sensitive parameters in the model such as soil thickness, lateral hydraulic conductivity, and temperature and precipitation lapse rates, are adjusted to fit the simulated data to the observed data. The model is then validated by running simulations for a different time period for which there are historic data available. Initial conditions for the simulations are created by running one or more years of simulations and using the resulting soil moisture and snowpack conditions as the initial conditions for subsequent simulations.

The DHSVM was calibrated to WY 2006 and 2007, and validated via simulation of WY 2008 and 2009. Initial conditions were established through simulation of fifteen months, including WY 2000 and the first three months of WY 2001; this provided initial conditions to begin each fifty-year simulation on January 1. The calibration and validation periods were chosen due to the availability of streamflow data at the USGS North Cedarville gauge (USGS #12210700), downstream of the confluence. Since the future simulations are fifty years in length, I would have preferred to calibrate to a longer record of streamflow, but the Cedarville gauge only has observations for four complete water years. The Deming gauge, which was in service until 2005, was also located downstream of the confluence of the river and has a longer record of observations, but the quality of the data is poor due to episodic changes in channel morphology (USGS, 2010).
Historic daily streamflow data for the Nooksack River from the North Cedarville and Ferndale (USGS #12213100) gauging stations were used for the calibration and validation process. Data were downloaded from the USGS Washington Water Science website (http://wa.water.usgs.gov/realtime/htmls/nooksack.html). The stream gauge instrumentation are calibrated a minimum of one time a year, and data are listed as approved or provisional pending review (USGS, 2010). All streamflow data used in the calibration and validation were approved with the exception of data for WY 2009. The USGS rates the quality of data at North Cedarville as fair (poor where estimated), at Ferndale as good, at Glacier as fair, and at Wickersham as good (USGS, 2010). Daily SWE data from SNOTEL stations, including Wells Creek SNOTEL (North Fork, elevation = 1230 m), Middle Fork Nooksack SNOTEL (elevation = 1506 m), and Elbow Lake SNOTEL (South Fork, elevation = 924 m), were downloaded from the NRCS website (http://www.wcc.nrcs.usda.gov/snotel/Washington/washington.html). Precise locations of SNOTEL stations for the purposes of locating the pixel in which the station is located were obtained by request from the NRCS.

The calibration process included comparison of simulated values to observed values using a variety of metrics and evolving strategies to most accurately capture the runoff-producing processes in the basin. To analyze the total annual streamflow, total annual SWE and to compare plots of streamflow and SWE, I imported the output into Excel and/or R (R Development Core Team, 2008), converted from m³/3-hours to cubic feet per second (cfs), and computed daily and monthly streamflow statistics such as mean and median flow. I compared the simulated and observed streamflow and SWE values visually, compared the
total annual streamflow and SWE for each year, and calculated the Nash-Sutcliffe (1970)
efficiency ($E$) and coefficient of determination ($r^2$; Krause et al., 2005):

$$ E = 1 - \frac{\sum_{i=1}^{n}(O_i - P_i)^2}{\sum_{i=1}^{n}(O_i - \bar{O})^2} $$

$$ r^2 = \left(\frac{\sum_{i=1}^{n}(O_i - \bar{O})(P_i - \bar{P})}{\sqrt{\sum_{i=1}^{n}(O_i - \bar{O})^2 \sum_{i=1}^{n}(P_i - \bar{P})^2}}\right)^2 $$

Where $O$ is the observed value and $P$ is the predicted, or simulated, value. The range
of $E$ is 1, which indicates a perfect fit, to $-\infty$; the range for $r^2$ is 0 to 1, with values closer to 1
indicating a better fit. Previous calibration results of the DHSVM in the Middle Fork of the
Nooksack River (Donnell, 2007) and the Thunder Creek basin in the North Cascades
(Chennault, 2004) were used as a basis for my calibration process. For snowmelt-dominated
basins, the most sensitive calibration parameters are those that control the amount and timing
of snowfall, and the amount and timing of snowmelt. Soil parameters are secondary to
temperature and precipitation lapse rates, and to threshold temperatures for rain versus snow,
which are strong controls on the shape of the monthly hydrograph and plot of SWE
(Chennault, 2004; Donnell, 2007).

### 3.3 Climate Change Forecasts

#### 3.3.1 General Circulation Models

General Circulation Models (GCMs) are coupled ocean-atmosphere 3-D models that
divide the surface into grid boxes that extend vertically into the atmosphere. At each time
step, within each box the model calculates the transfer of energy, mass and momentum based on the ‘first relationships’ described by atmospheric physics. Computational efficiency of the models requires a coarse spatial resolution (on the order of 100s of km per side) and thus requires parameterization of relationships that are below the resolution of the model (e.g., cloud formation). The models are developed and run by large research institutions such as the Goddard Space Science Institute, who make their data publicly available.

In order to understand the impact of anthropogenic changes on the global climate system, the emissions of greenhouse gases are related directly to a positive radiative forcing due to the net energy imbalance created by the increased storage of energy. The GCM is run using the change in net energy in the climate system and the model characterizes changes in air temperature, water temperature, precipitation, and other climatic factors (IPCC, 1997).

### 3.3.2 GCM–Emissions Scenario Couples

Since emissions of greenhouse gases are directly related to a positive radiative forcing, it is necessary to describe future emissions in order to model future global climate. Forty emissions scenarios were developed by institutes associated with the IPCC in order to model a range of future climate possibilities. Each scenario describes the population, technology, and economy of the world into the future, and relates levels of emissions to the hypothetical future world. The scenarios are considered equally likely. The A2 scenarios describe a future that includes continued population increase and an economy based on the intensive use of fossil fuels. The B1 scenarios characterize a future in which world population peaks and then declines, with a focus on alternative energies and economies (IPCC, 2000).

GCMs are run using a specific emission scenario and the associated radiative forcing related to the emissions levels described in that scenario. Each model represents the climate
system differently, based on spatial resolution and levels of parameterization of processes. Thus, even utilizing the same emissions scenario, each GCM will provide a different forecast. For the PNW, ten GCMs predict average warming of 0.5-2.5°C by the 2040s, with a range of possible warming provided by both the different GCMs and their combinations with two different emissions scenarios (Mote et al., 2005). The same group of GCMs differ as to whether precipitation in the PNW will increase or decrease into the 2040s.

With future climate being based in part on different conditions, and with the varying levels of spatial resolution and complexity represented by the different GCMs, it is preferable to use a suite of models and scenarios to predict a range of possible future climate conditions rather than a single forecast. I used the same three GCM-emissions scenario couples used by the CCTC, each representing a cluster of GCM-emissions scenario predictions for temperature and precipitation in the PNW by the 2040s (Figure 2). These include the:

- **IPSL_CM4_A2** (GCM from the *Institut Pierre Simon Laplace*, with A2 emissions scenario, hereafter IPSL_A2) which represents a group of couples that predict increase in temperature of 2-5°C and 8-9% increase in precipitation by 2040.

- **Echam5_A2** (GCM from the *Max Planck Institute for Meteorology*, with A2 emissions scenario, hereafter Echam_A2), which represents a “middle of the road” scenario with 2% precipitation increase and 1.7°C increase.

- **GISS_ER_B1** (GCM from the *Goddard Institute for Space Studies*, with B1 emissions scenario, hereafter GISS_B1), which represents the group of couples that predicts a 0.5-4.0% decrease in precipitation along with a 2-5°C increase in temperature (Mote et al., 2005; Polebitski, 2007b).
3.3.3 GCM Downscaling

The GCM outputs are provided on a coarse spatial and temporal scale and are
inappropriate for use in a regional hydrologic study. The spatial scale is on the order of 100
km per grid cell side and the predictions may be for just four to six locations for Washington
State. The GCM output includes monthly mean temperature values and total monthly
precipitation values, whereas a regional hydrology model requires meteorological input at a
daily to sub-daily time step. Neither the spatial nor the temporal variability of weather are
adequately represented in the GCM predictions. Therefore, the GCM data must be converted
to a finer scale in order to use the forecast data for basin-scale hydrology modeling. Through
statistical downscaling, I combined GCM forecasts with historic weather data for the
Nooksack basin to develop a local-scale climate prediction to use as the meteorological
forcing in the DHSVM. Statistical downscaling relates the statistical properties of the
predicted data to those of the historic data, and utilizes the relationship to translate the
forecast to a smaller spatial scale. The downscaled local prediction captures important local
and regional meteorological influences such as topography and local weather patterns.

Three general types of statistical downscaling are recognized: a delta method, a bias-
correction statistical downscaling method (BCSD), and a hybrid method (Hamlet et al., 2010).
The delta method and the hybrid method both utilize a shifted version of the historical
meteorological record as the future forecast. The goal of both of these methods is to use the
GCM forecast to provide the underlying future climate trend while preserving the full range
of temporal variability of weather at a local level, including extreme events (Polebitski et al.,
2007; Wiley et al., 2006). These methods preserve historical patterns and variability by
incorporating the time series of the historic data into the downscaling, rather than the time
series of forecasts. Therefore, one inherent limitation is that these methods do not account for the changes in weather patterns that may occur synchronously with changes in temperature and precipitation (Polebitski et al., 2007b). The delta method uses a simple average of the monthly change predicted by the GCM and applies that mean change to each month the historical series. The hybrid method applies the entire distribution of monthly change predicted by the GCM to the historical series. The BCSD method uses the time series of the forecast data directly, which allows for characterization of future weather patterns and inter-annual variability, but relies on the quality of the GCM data. The coarse spatial resolution of the GCM data may not characterize the local weather effects of a particular watershed, and therefore may mischaracterize its variability. The methods of this study fall into the hybrid category, in which the distribution of predicted future climate is mapped onto the historic record of climate. Empirical cumulative distribution functions (eCDFs) are calculated for monthly temperature and precipitation data from the historic record and from GCM simulations of the same period; transform functions are created from the relationship between the two data sets and used to shift the local meteorological record to reflect the statistics of the GCM forecasts.

The downscaling process requires mean monthly historical temperature (°C) and total monthly precipitation (mm) for 1950-1999. I used historical daily meteorological data from the Abbotsford station and aggregated the daily data to the mean monthly temperature and the total monthly precipitation. The downscaling process was performed primarily in R (see Appendix B for example code).

Following the work of Wiley et al. (2006), Polebitski et al. (2007b), and Wiley and Palmer (2008), I began with GCM data that were previously bias-corrected and statistically
downscaled to 1/8° resolution. These data, the World Climate Research Programme's (WCRP's) Coupled Model Intercomparison Project phase 3 (CMIP3) multi-model dataset were produced following the methods of Wood et al. (2002; 2004), and Maurer (2007), and include regionally downscaled datasets for the three GCM-emissions scenario couples that I chose to use. The CMIP3 forecast data were downloaded from their website in ASCII format for January 1950 through December 2099 for the specific grid cell in which the Abbotsford station is located (Latitude bounds: 49.0, 49.125, Longitude bounds: -122.375, -122.25).

Subsequently, my first step in the downscaling process was to bias-correct the 1/8° degree resolution forecast data to the scale of the Nooksack basin. I used a historical gridded dataset (Maurer, 2002) at the same resolution as the CMIP3 forecast data (1/8°), to compare to the Abbotsford data for the same time period, 1950 through 1999, in order to identify bias between the different resolution historical records. The bias between the two historical records is used to create a quantile map that is then applied to the 1/8° CMIP3 forecast data in order to bias-correct the regional forecasts to the local scale, and produce a local hindcast and forecast for 1950 through 2099.

The 1/8° resolution historical gridded dataset was obtained from the Surface Water Modeling group at the University of Washington from their web site (http://www.hydro.washington.edu/Lettenmaier/Data/gridded). Daily historical temperature and precipitation are gridded to 1/8° resolution from point observations and statistical analyses described by Maurer et al. (2002). The gridded data were downloaded as a compilation of binary files for the Northwest and Columbia River region, and I used MATLAB to extract the closest grid cell to which Abbotsford is located (centered on 49.0625, -122.4375), to convert the file to an ASCII format, and to add the time series.
Both the spatial and the temporal resolutions of each dataset had to be considered during the downscaling process. The CMIP3 forecast data consists of monthly mean temperature and monthly precipitation rate (mm/day), from which I calculated total monthly precipitation. Consequently, all comparisons between the Abbotsford and historical gridded datasets needed to be completed as monthly mean temperature and total monthly precipitation. Therefore, for the historic gridded data, I calculated daily mean temperature as the average of daily minimum and maximum temperature, and aggregated the data to monthly mean temperature and monthly total precipitation.

Rather than comparing corresponding time series values (e.g., comparing January 1960 total precipitation for both datasets), I used the corresponding probability distribution of each dataset to compute the bias. I calculated the monthly eCDF for each variable by using the Wiebull plotting position as a proxy for non-exceedance probability ($P_{ne}$), which is the probability that the value (e.g., temperature) will be less than or equal to a specific value in the distribution:

$$P_{ne} = \frac{z}{n + 1}$$

where $z$ is equal to the rank of the value in order from lowest to highest (i.e., the lowest value has a rank of 1), and $n$ is equal to the total number of values (Figure 3; Stedinger et al., 1993). I compared each eCDF (e.g., January temperature) for the Abbotsford dataset to the historical 1/8° gridded dataset, and calculated the difference between each pair of ranked values as a difference in temperature ($\Delta T$) or a ratio of precipitation ($\Delta P$; Figure 4). The resulting dataset of $P_{ne}$ and the associated $\Delta T$ or $\Delta P$ values is the quantile map for that month, which I then used to bias-correct the forecast data for the same month (Wood et al., 2002).
The monthly eCDFs for the CMIP3 forecast data were computed and used to order the dataset, and the quantile map was then applied to the monthly forecast so that a $\Delta T$ value was applied to the forecast temperature that has the same $P_{ne}$ as the historical temperature value. The CMIP3 data include 1950 – 2099, whereas the quantile map was created from fifty years of historical data (1950-1999). The difference in lengths between the two datasets required the interpolation and extrapolation of values in the quantile map in order to make it the same length as the forecast data, and thus contain the same series of $P_{ne}$. I used a natural spline function to lengthen the quantile maps to 150 values. Then, I applied the maps to the forecast data, adding the $\Delta T$ value and multiplying by the $\Delta P$ value to the forecast values with the same $P_{ne}$. The result is monthly bias-corrected GCM forecasts for average temperature and total precipitation for the time period of 1950 through 2099, which have been downscaled to local-scale resolution.

My final downscaling step was to create a shifted Abbotsford time series to use for hydrologic modeling. The statistical characteristics of a portion of the forecast data are used to shift the magnitude of the Abbotsford time series in order to capture both the steady-state future climate, and local weather patterns and variability. In this step I extracted a 31-year slice, of the local bias-corrected GCM forecast data, centered on the year of interest (e.g., 2025). The length of the portion of forecast was chosen to represent the steady-state of climate centered on 2000, 2025, 2050, and 2075; thirty years is commonly used as the time period that is representative of climate. I computed the eCDF for each month and variable of the 31-year slice and of the 50-year Abbotsford monthly values (Figure 5). I used a natural spline function to interpolate the $P_{ne}$ values and associated meteorological values of the 31-year slice to the same length as the 50-year Abbotsford time series and ordered both datasets.
by \( P_{ne} \). The \( \Delta T \) and \( \Delta P \) between each ranked value in the two datasets were calculated to create the quantile map for each month and variable. I then applied the \( \Delta T \) and \( \Delta P \) values to the 50-year Abbotsford time series of minimum daily temperature, maximum daily temperature, and total daily precipitation (Figure 6). The daily temperature range observed at Abbotsford is preserved in the downscaling process because the bias is calculated between mean temperature values and then applied to both minimum and maximum temperature. The daily values were then disaggregated into a 3-hour time step and used to derive the other DHSVM meteorological inputs in the same manner used for the calibration and validation data.

### 3.4 Hydrologic Modeling

#### 3.1.1 DHSVM Simulations

Simulations were run with a calibrated and validated model using the calibration parameters, and three forecasted datasets, each downscaled from a different GCM, to represent four periods of climate: 2000, 2025, 2050, 2075. Each meteorological data set is the fifty year Abbotsford time series (1950-1999) that has been shifted to represent the 31-year climate trend centered on 2000, 2025, 2050, and 2075. Additionally, simulations were performed using the disaggregated Abbotsford time series to create a historical simulation, which provides a basis for comparison with future simulations. Initial conditions were provided by the output from the validation runs, and therefore represent present day conditions.

The DHSVM is written in ANSI-C and can be run on a variety of platforms. I used a Linux operating system on a Dell Precision with a 2GHz processor in Dr. Robert Mitchell’s
hydrology modeling lab. Each 50-year simulation required approximately 18 hours of computing time. WinSCP2, a secure shell, was used to transfer input and output files between the Linux system and a PC. Aggregation, conversion, and analysis of streamflow and SWE results was completed in R and Excel, with R being preferable due to its ability to read and process datasets that are larger than the bounds of what Excel can import.

3.1.2 Streamflow and SWE Analysis

Local climate forecasts and present day basin characteristics, such as vegetation and topography, were used as input to the DHSVM to predict future SWE and streamflow under changing climate conditions. The DHSVM output includes streamflow at the time-step at which the model is run for a designated stream segment, typically chosen based on the location of a stream gauge. Additionally, individual pixels can be designated to save time-step data including SWE, soil moisture, and total evapotranspiration. I chose pixels at the three SNOTEL sites to capture continuous output of SWE for the entire duration of each simulation.

I analyzed results from the forecast modeling to predict the changes in central tendency (e.g., mean or median) and range of monthly median discharge in the Nooksack River and monthly mean SWE at three SNOTEL stations. These analyses focused on the trends in streamflow and SWE, and the changes in the 50-year distributions of monthly values rather than the time series itself, which is a shifted version of the historical time series. Peak flow events can skew monthly mean discharge magnitudes and misrepresent the streamflow distribution. Hence, I chose the median, rather than the mean to characterize streamflow because the median is more resistant to outliers (Helsel and Hirsch, 2002). Mean
SWE was used to characterize snowpack because SWE has less variability and thus mean and median are very similar.

3.1.3 Peak Flow Analysis

The maximum simulated streamflow for each water year was extracted from the 3-hour time series to analyze trends in magnitude and timing through time in annual flood peaks. The maximum instantaneous peaks observed at the Ferndale gauging station were compared to those simulated at North Cedarville because, although differences are expected between the stations, the Ferndale record provides a good proxy in the absence of a reliable longer record at Cedarville. Variations between peak discharge at the two locations do arise, however, due in part to overbank flow in Everson when discharge in Deming is over approximately 46,000 cfs. Thus, the peak flow record at Ferndale is considered a mixed population record, and efforts have been made to reconstruct the annual peak flow record at Ferndale for use in flood frequency analysis (Delbert D. Franz, Linsley, Kraeger Associates, Limited, 2005). The same methodology was used to assess the distribution of spring peak flows by identifying the maximum 3-hour streamflow value from March through June for each water year. Spring flood peaks are of interest due to their use in the design of agricultural levies; peak flow events during the planting season potentially have a greater economic effect on the farms than floods during the winter months (P. Cooper, personal communication, 2010).

Peaks-over-threshold analysis on daily peak flows was completed to provide some indication of changes in frequency and timing of flows over certain thresholds, which may be masked by annual maxima analysis. Thresholds of 30,000, 40,000 and 50,000 cfs were chosen because flows of approximately 37,000 cfs spill overbank near the confluence, and
flows over approximately 46,000 cfs create overflow at Everson which runs off to Canada (P. Cooper, personal communication, 2010). Peaks-over-threshold analysis assumes that each peak is an independent event. This assumption was met through aggregation of 3-hour streamflow to daily mean flows and by manual deletion of peak flows from consecutive days.
4.0 Results

4.1 Hydrologic Model Calibration

4.1.1 Calibration and Validation Results

Calibration of the DHSVM was an iterative process; each failed attempt informed an evolving strategy to recreate recorded discharge measurements in the Nooksack River. Early simulations under-simulated base flow and spring melt peaks. Increases in the precipitation lapse rate added more streamflow and SWE to the system (Table 1). Additionally, I experimented with using the PRISM maps to spatially distribute precipitation, but the simulated hydrographs completely missed some peak flow events; thus, I chose to use a constant precipitation lapse rate. Timing of the onset of snow accumulation, and of spring melt was adjusted via monthly variable temperature lapse rates to simulate the shape of the monthly hydrograph. Soil thickness, soil porosity, and lateral hydraulic conductivity of the three most dominant soil types in the basin (soil types 3, 4, and 6) had a moderate effect on base flow. Increases in soil thickness and porosity, and decreases in lateral conductivity simulated more storage and slower release of soil water in the basin, better reproducing the level of base flow between storm events.

The annual totals of daily SWE and streamflow, the shape of the accumulation and recession curves, and the time series of both median daily streamflow and median monthly streamflow were compared between the simulated and observed data as indications of the accuracy of the simulation. The model was considered calibrated and validated with a Nash-Sutcliffe efficiency ($E$) of 0.56 for the validation period, a coefficient of determination ($r^2$) of
0.57, and with the two-year annual sum of daily simulated streamflow total within 10% of observed streamflow (Krause et al., 2005). Additionally, visual comparison of the daily and monthly hydrographs showed that the shape of the recorded hydrograph had been replicated (Figure 7). The calibrated parameters provided a good fit for most of the four years under consideration, but led to under-simulation of streamflow in winter of 2007/2008. Further adjustment of the calibration parameters failed to more accurately simulate that winter without causing the rest of the simulation to become less accurate. Therefore, I questioned whether this was a microclimate phenomenon in which the precipitation recorded at the Abbotsford station may have excluded a major storm. I tried using disaggregated meteorological data from the COOP Newhalem station, southeast of the Nooksack basin, along with the Abbotsford data to force the model in order to capture weather patterns originating from the south; however, the additional meteorological data simply increased streamflow in all years, rather than changing streamflow in the one anomalous year.

Additional validation of the calibrated model is provided by comparison with the streamflow record at the Ferndale gauge. Although Ferndale is located close to the mouth of the Nooksack River and downstream of numerous artificial inputs and outputs to the stream, the shape of the hydrograph at Ferndale mimics the shape of the hydrograph recorded at the Cedarville gauge. In order to use the Ferndale record for further comparison, I simulated WY 2001 through 2005, for which there are no streamflow data at Cedarville. These streamflow data were compared to the observed streamflow at Ferndale to qualitatively confirm that the calibrated model would reproduce the observed hydrograph (Figure 8).

The calibration and validation simulations showed close comparisons with recorded SWE at Middle Fork Nooksack SNOTEL and Wells Creek SNOTEL in the North Fork basin;
however, SWE at the Elbow Lake SNOTEL in the South Fork basin was consistently under-simulated by the model (Figure 9). Adjustment to parameters that increased SWE at Elbow Lake led to over-simulation of snowpack at Wells Creek. One possible explanation for this response is that the weather observed at the Abbotsford station does not fully represent the weather patterns in the South Fork basin, which often originate further south. Clouds moving up the north-south oriented valley at the headwaters of the South Fork can get stalled at the ridge that divides the Middle Fork and the South Fork, and lead to more snow accumulation than expected based on a simple precipitation lapse rate (S. Pattee, personal communication, 2009). In an attempt to resolve this problem I delineated the basin into two watersheds, a South Fork watershed and the remainder of the upper Nooksack basin, in order to establish the ability to manipulate parameters in the South Fork basin only. I found that parameter adjustments that created more snowpack in the South Fork also led to increases in the spring melt hydrograph peak that were well above the recorded streamflow at the Wickersham station in the South Fork. Thus, I chose to model the entire basin together and to use the parameters that led to accurate simulations of streamflow and SWE at Wells Creek SNOTEL and Middle Fork Nooksack SNOTEL, and under-prediction of SWE at Elbow Lake SNOTEL. Additional validation of the ability of the calibrated model to reproduce accurate snowpack at the SNOTEL stations is provided by comparing the full length of the observational record at each station to simulation of the same time period (Figure 10). These comparisons illustrate that some years are better represented than others, but that overall, SWE at both Wells Creek SNOTEL and Middle Fork SNOTEL is accurately simulated by the DHSVM.
4.1.2 Uncertainty in Model Calibration

The accuracy of calibration of the model is judged on its ability to reproduce observed streamflow and SWE rather than the accuracy of the model parameters or input data. Input parameters are adjusted in the calibration process, but values that are known to vary through time, such as the rain/snow threshold temperatures and the snow water capacity require a temporally constant value. A constant precipitation lapse rate and monthly temperature lapse rates were used, despite the evidence that lapse rates vary both temporally and spatially and are subject to local topographic effects (Lundquist and Cayan, 2007). The spatial data used in this study were acquired through field observations, aerial photographs, and remote sensing methods (e.g., Golden, 1992). The quality of these data is limited primarily by the density and quality of point measurements that are used to interpolate spatially continuous data grids. Soil type and soil depth have the largest associated uncertainty due to the low density of field measurements and derivation from the elevation data. In addition, all spatial data have been further generalized in the re-sampling process, and some spatial characteristics of the basin, including the road network are not represented.

Calibration of the model is based on the assumption that the recorded values for observed streamflow and SWE are accurate. Both streamflow and SWE measurements are affected by the quality and functionality of instrumentation, as well as the accuracy of recording and reporting the observations (e.g., rating curves). Streamflow values for high flow events are derived from a rating curve rather than direct measurement above a certain threshold, and therefore are subject to greater error. Thus, in the calibration process more emphasis was placed on the overall shape of the hydrograph rather than the magnitude of peak flows. Artificial inputs and outputs that are not accounted for in the model can also
affect the accuracy of the calibration. The City of Bellingham diverts water from the Middle Fork of the Nooksack River into Lake Whatcom to provide drinking water. The diversion accounts for less than 2% of the yearly discharge in the Middle Fork, so the effect on discharge downstream of the confluence is small (Donnell, 2007). SWE measurements are additionally affected by wind transport of snow onto or off of the snow pillow sensor, human and animal interaction with sensors, and vegetation growth over time, which can lead to canopy interception of snow and changes to local wind effects.

4.2 Local Climate Change Forecasts

4.2.1 Local Forecast Results

Validation of the forecast data and downscaling methodology is provided via comparison between Abbotsford data and downscaled hindcast data for the same time period. Boxplots of the distributions of temperature and precipitation values for the downscaled GCM datasets for the 50-year period 1950-1999 are similar to the distributions of values from Abbotsford for the same period (Figure 11; the box represents the 25th-75th percentiles, the line shows the median, the whiskers extend to the minimum and maximum, or 1.5 times the interquartile range, and the dots are outliers). The similarity is further illustrated by the eCDFs; however, the hindcast data consist of slightly warmer temperatures throughout the distribution (Figure 12). The maximum difference is less than 0.5°C for all three GCMs. The eCDFs of total monthly precipitation also show that the hindcast precipitation values are slightly higher than the historical values, especially toward the higher end of the distribution (Figure 13). The maximum difference is 42 mm and the mean difference is 8 mm.
All three downscaled forecasts predict an increase in monthly mean temperature in all months relative to the observed temperature data, for all four future periods of climate (Figures 14 and 15). The magnitude of temperature increases vary seasonally, with the sharpest increases in the summer (Table 2). The magnitude of change also varies between the three GCM-based forecasts. The variability of forecasts for the same period of future climate (e.g., 2025) provides an indication of the range of possible future climate change. The eCDFs of all three models, however, show a clear shift of the entire distribution of monthly values toward warmer temperatures in 2025 and beyond (Figure 16).

In contrast, the precipitation forecasts vary in both direction and magnitude between seasons and between the three GCMs (Table 3; Figures 17 and 18). In most cases the three forecasts predict increases in precipitation relative to historic observations in all seasons except summer. The IPSL_A2 and Echam_A2–based forecasts predict overall increases through time in winter precipitation. The GISS_B1-based forecast predicts a decrease from 2000 to 2075, but an overall magnitude that is greater than the historic period.

The eCDFs of temperature and precipitation values illustrate the different patterns in the forecasts (Figures 16 and 19). The entire distribution of monthly mean temperature shifts to the right, toward warmer temperatures, through time. Precipitation increases are concentrated in the middle and extreme high ends of the distributions. The extreme high end of the tail of the eCDFs is lengthened in the 2075 forecast, indicating higher magnitude extreme precipitation events.

4.2.2 Uncertainty in Local Forecasts

The most important source of uncertainty in the local forecasts is the GCM on which they are based, and the uncertainty of each forecast increases into the future (Polebitski et al.,
Each GCM forecast depends on the structure of the general circulation model, the emissions scenario, and the initial conditions and parameters that are used to force the model. My choice of three GCM-emissions scenario pairs is intended to bracket some of the range of GCM forecasts; however, with many more GCMs and emissions scenarios, this study does not represent the upper and lower limits of possible future climates. Additionally, the accuracy of the downscaling process depends on the quality of the Abbotsford data and of the historical gridded dataset used for adjusting the resolution of the forecast data, and on the downscaling methodology. The use of the gridded dataset and the downscaling methodology were patterned after previous studies to the extent possible (Polebitski, 2007a, and Polebitski, 2007b; see Appendix B for annotated downscaling functions). Uncertainty in the forecast data precludes the ability to accurately predict a single time series of future streamflow and SWE in the Nooksack River basin. Therefore, streamflow and SWE results are described primarily in terms of changes in the 50-year distributions, including the shift of central tendencies and ranges.

4.3 Hydrologic Modeling of Future Conditions

4.3.1 Snow Water Equivalent Results

Snow water equivalent at all SNOTEL sites is predicted to decrease through time for every month. Monthly mean SWE for the 50-year simulations illustrates the negative trends in snowpack through time (Figures 20, 22 and 24). Boxplots characterize the entire range of SWE values for each month and illustrate the variability of future SWE under each period of climate (Figures 21, 23 and 25). April 1 is typically considered the timing of peak SWE in western river basins, but GISS_B1 and IPSL_A2 simulation results include a shift of the
timing of the peak SWE to March by 2025 for the Wells Creek SNOTEL, and by 2050 in the Echam_A2 simulation. The timing of peak SWE at the higher elevation Middle Fork Nooksack SNOTEL is predicted to shift to February or earlier by 2075 in the Echam_A2 and IPSL_A2 simulations. With melting of the snowpack occurring earlier in the year, the number of months with no snowpack at the SNOTEL sites increases.

4.3.2 Monthly Streamflow Results

Simulations of future streamflow in the Nooksack River predict changes in both magnitude and timing, including increases in winter streamflow, decreases in summer streamflow, and a shifting of the spring melt peak (Table 4; Figures 26 and 27). The GISS_B1-based forecast predicts more moderate changes to streamflow, whereas the Echam_A2 and IPSL_A2-based forecasts predict more drastic changes. Results for magnitude of future streamflow are therefore variable, with increases in winter discharge ranging from 40-77% by 2050.

The timing of the spring peak flow is predicted to change with climate along with the timing of peak SWE. The GISS_B1-based simulations predict a shift of the spring melt peak from June to May by 2050. The other two forecast simulations indicate a flattening out of the spring melt peak by 2050, leading to a one-peak hydrograph for the Nooksack River. Boxplots of fifty years of monthly median discharge illustrate that the range of flows is expanded in the Echam_A2 and IPSL_A2 simulations. Extreme high flows in the winter months and extreme low flows in the summer months surpass historical extremes.

4.3.3 Glacial Contribution to Streamflow

In order to understand how the interaction of changing climate and changing glacier extent may affect future streamflow, all simulations were performed with and without the
2001 glacier coverage in the basin. Since glaciers are included in the landcover input to the DHSVM, they were reclassified as open shrub vegetation for the deglaciated simulations. The glacier classification requires SWE to be reset to 5m if it drops below 1m during any time step of the simulation, representing the glacier as an inexhaustible snowpack. The reclassification of the landcover from glacier to shrub theoretically allows snowpack to accumulate and melt depending on the environmental conditions rather than forcing the pixels to maintain ice coverage through all time steps. The intent of these simulation pairs was to calculate the glacial contribution to streamflow as the difference in streamflow between the glaciated and deglaciated simulations. Therefore, the two sets of simulations would establish the total contribution of glacial melt to streamflow under 2001 glacier extent and future climate conditions.

Sensitivity analysis of SWE at pixels along a transect from the low elevation to the high elevation portions of a glacier revealed the flaw in this strategy. The SWE difference between the glaciated and deglaciated simulations was apparent only at the lowest elevation glacier pixels. At mid- to high-elevation pixels SWE consistently accumulated throughout the 50-year simulations, with no difference between the pairs of simulations (Figure 28). In DHSVM v2.0 there is no glacier flow component, so snow that accumulates on a pixel can only be removed via melting. Thus, the glacial contribution to streamflow calculated via the difference between the two scenarios captured only the contribution of the lowest glaciated pixels and does not accurately quantify the glacial contribution to streamflow under changing climate conditions.
4.3.4 Peak Flows Results

The maximum simulated discharge (peak flow) for each water year of the historical simulation was extracted from the 3-hour time series for comparison with recorded annual peak flows at Ferndale (Figure 29). Although there is some variability in the time series of annual peaks flows, the distributions are similar, providing some validation that simulation is capturing the magnitudes of annual peak flow events (Figure 30). Boxplots and eCDFs illustrate increases in the ranges and medians of future annual peak flows (Figures 30 and 31). The predictions vary considerably depending on the climate forecast. The Echam_A2 and IPSL_A2 forecasts produce simulated annual peak flows that are much higher in magnitude than those produced by the GISS_B1 forecast. The shifting of the eCDFs of the annual peak flows to the right corresponds to the shifting of return periods. For example, the magnitude of the 5-year flood (non-exceedance probability of 0.8) is predicted to become the magnitude of the 2-year flood (non-exceedance probability of 0.5) by 2025 (Figure 31). Similarly, the distribution of the maximum spring flows are also predicted to shift to higher magnitude flows at lower return periods (Figure 32).

The frequency of peak flows above threshold values of 30,000, 40,000, and 50,000 cfs increases through time (Figure 33). The Echam_A2 and IPSL_A2 forecasts predict larger and more sustained increasing trends through time than the GISS_B1 forecast. Histograms illustrating the timing of flows above 30,000 cfs yield evidence of an overall increase in peak flow events in January and a shift from November to January as the dominant month for floods to occur (Figure 34). The total number of peak flow events varies between the histograms so recognizing shifts in timing may be complicated by the change in the number of events.
5.0 Discussion

5.1 Variability in Streamflow and SWE Predictions

Simulations of future streamflow in the Nooksack River predict a range of magnitudes for future changes, which include increasing winter flows, decreasing summer flows, and a shift in timing of the spring melt peak. The variability in streamflow predictions reflects my use of three different GCM-based climate forecasts. Whereas the three forecasts are consistent in their prediction of increasing temperatures, they vary with respect to the magnitude of temperature increases and both the direction and magnitude of future precipitation. Simulations based on the IPSL_A2 and the Echam_A2 forecasts, both of which are coupled with the higher emissions A2 scenarios, illustrate streamflow responses to more drastic changes in future climate. The simulations based on the GISS_B1 forecast provide predictions for streamflow response to more conservative climate changes. The changing shape of the distributions of temperature and precipitation values through time, rather than a direct translation of the median and ranges of the distributions to lower or higher values, underscores the reason to simulate streamflow under multiple versions of future climate conditions.

Multiple predictions for streamflow and SWE should be considered equally valid realizations since each emissions scenario is a probable political, energy, economic, and population narrative. It is impossible to choose one forecast of the future because future emissions of greenhouse gases are highly uncertain. Van Vurren and O’Neil (2006) assessed the emissions scenarios by comparing emissions, economic, and population indicators in the scenarios with more recent data and updated global projections of the indicators, and found
that all of the scenarios remained plausible. Recent CO$_2$ emissions are within the middle to upper range of the pathways described by the emissions scenarios, but substantial divergence of the pathways is not predicted to occur until after 2025 (Manning et al., 2010).

The variability in my modeling results also reflects a fifty-year range of weather observations at the Abbotsford station. By combining the future trends predicted by the GCM forecasts with the Abbotsford time series, the local-scale forecasts include both natural and anthropogenic climate variability. Many cycles of the interannual ENSO are represented since its period ranges from 6-18 months. The majority of two epochs of the interdecadal PDO are also included, including a cool phase from 1947-1976 and a warm phase that began in 1977 (Mantua and Hare, 2001). The local effects of these cycles, along with weather patterns, in the forecast data allows predictions of future streamflow and SWE to be derived from the full range of natural variability observed locally. One point to consider, however, is whether this variability adequately reflects the next fifty years of weather. Global temperature change may be an important factor in the seasonal timing of ENSO, for example (Tsonis et al., 2003). Natural variability may be fundamentally altered by changing climate conditions, but those effects are not represented in these predictions.

5.2 Comparison to Other Studies and Time Periods

My modeling results for the Nooksack River are similar in general trends, though variable in magnitude, to predictions made for the Nooksack River and for other western Washington rivers (CIG, 2010; Polebitski et al., 2007c). Simulations of future streamflow in the Nooksack River by the Climate Impacts Group (CIG) demonstrate similar patterns through time. Their results, from modeling streamflow with downscaled forecast data and
the 1/16° resolution VIC model, include increases in winter streamflow and a flattening out of the spring peak of the hydrograph (CIG, 2010). However, streamflow in the Nooksack River is predicted to change more quickly and more drastically in comparison to other regional rivers, including the Green, Tolt, Sultan, White, and Cedar Rivers (Polebitski et al., 2007c). Streamflow in the Nooksack River may be more strongly controlled by snowpack than other regional rivers due to its location in the North Cascade mountains. Snowpack-dominance makes the basin highly sensitive to temperature changes. Future temperature predictions for the Abbotsford station are, on average, about 0.2 to 1°C higher relative to the historic period than the mean changes forecasted by the CCTC; however, the CCTC used a longer historic period as a reference (1928-2004), so the two are not directly comparable. Similarly, although this study is modeled after the work of the CCTC, some variation in predictions may result from variations in methodology. Differences include the utilization of a different version of the DHSVM, a different strategy for modeling the effect of glacier retreat along with climate change, and minor variations in downscaling methodology. Regardless of the variability between the studies, comparisons of regional streamflow predictions are useful for monitoring how each river and the entire region changes through time.

Although I use the historical simulation as a basis for comparison with the future simulations, the 2000 simulation may also be a useful base from which to measure change relative to modern conditions. The rate of warming of global surface temperature has increased in the last quarter of the 20th century; hence the 2000 simulation characterizes some of the changes which have already begun to occur in the Nooksack River basin. The downscaled forecasts for 2000 are based on the climate represented by 1985-2015.
range of temperatures recorded during that period (1985-2009) at the Abbotsford station are more similar to the 2000 forecast than to the 1950-1999 observations (Figure 35). The historical simulation, which is based on 1950-1999 data, may mute some of the warming of the last 30 years (Hamlet and Lettenmaier, 2007). However, the 2000 hydrologic simulation is based on downscaled, modeled data, whereas the historical simulation is based on local, observed data. Thus, the historical hydrologic simulation is used as the primary comparison in this study.

5.3 Influence of Glaciers and Snowpack

Future work on quantifying the glacial contribution to streamflow under the conditions of each forecast is needed to fully characterize future summer streamflow. My results fail to provide upper and lower limits, but the difference between the glaciated and deglaciated simulations do illustrate that summer flows will decrease even when only a small proportion of the glacier area is removed (Figure 36). Warming temperatures and a reduction in glacier extent will affect streamflow in the Nooksack River (e.g., Donnell, 2007). Glacial melt buffers summer streamflow by providing more melt water in warmer summers and less in cooler summers. If glaciers remained static in extent, increased temperatures would lead to increased melting and increased glacial contribution to summer streamflow, and a lengthening of the ablation season. However, glacier retreat combined with further increases in temperature will lead to a reduction in glacial contribution to streamflow, which will intensify the predicted low summer flows.

My modeling results illustrate that the seasonal snowpack, which develops and melts off completely in most years, exerts the most control over streamflow with changing climate.
Simulations of future SWE in the Nooksack basin indicate that maximum SWE will decrease through time, and the timing of peak SWE will shift to earlier in the season. These findings are consistent with work by Adam et al. (2009) that observed two systematic responses to temperature increases in snowmelt-dominated basins: a decrease in the ratio of snow to rain as winter precipitation and a shift toward earlier snowmelt. The air temperature controls whether precipitation will fall as rain or snow, effectively changing the total area contributing to runoff and thus discharge in the Nooksack River. Snow that falls in the basin can be stored until the spring or summer, reducing runoff in the wet fall and winter seasons and increasing streamflow in the dry summer season, or can quickly be melted off by warmer temperatures or warmer storm events. The predicted shift of peak SWE toward earlier in the year corresponds to an earlier spring melt peak in the hydrograph, and the decrease in peak SWE corresponds to the flattening out of the melt peak in the hydrograph. Under predicted climate conditions, warmer temperatures will melt the snowpack earlier in the year and less snowpack will develop.

Negative SWE trends through time predicted for the Nooksack River are consistent with other regional studies (e.g., Hamlet et al., 2005; Mote et al., 2005; and Mote et al., 2008), which found that long-term changes in SWE are controlled by changes in temperature rather than precipitation. Maximum SWE at the three SNOTEL stations in the Nooksack basin is predicted to decrease despite forecasted increases in winter precipitation. Similarly, the shift in the timing of maximum SWE predicted in the Nooksack basin is predicted despite increasing winter and spring precipitation. Previous work by Stewart et al. (2004) on the relationship between trends in temperature and precipitation during the 20th century, and their individual and combined effects on the timing of snowpack melt in the western U.S.,
indicated that temperature controls the timing of spring melt. In particular, warmer spring temperatures are the dominant factor in moving the spring melt to earlier in the year.

Analyses of SWE at pixels at different elevations on glaciers show that during a 50-year simulation there are unreasonable amounts of snow accumulating in the highest elevation portions of the basin, above approximately 2000 m (Figure 28). However, my modeling results for streamflow and SWE are not affected by this over-accumulation of snowpack because the melting that occurs at such elevations is limited by net heat input. Whether there is 10 m or 20 m of snowpack, the same quantity of snowmelt will occur. This hypothesis is supported by the month-to-month SWE values at the high elevation pixels, which demonstrate reasonable fluctuations, not excessive melt. Additionally, this accumulation phenomenon is restricted to high elevations. The accurate SWE simulations at the Wells Creek and Middle Fork SNOTEL stations for the full length of their records give confidence to SWE and streamflow predictions.

Although consistent over-accumulation was occurring at high elevations, there are also natural accumulations that were observed at the lower elevation SNOTEL stations. Boxplots of mean monthly SWE at the Middle Fork SNOTEL station for each year during the 50-year historical simulation reveals two periods of net accumulation: 1950-1957 and 1971-1976 (Figure 37). Observations from WY 2003-2009 at the MF SNOTEL station report zero snowpack in August and September for all years on record. Since both periods occur during the cool, wet phase of the Pacific Decadal Oscillation that dominated from 1947-1976, the snowpack accumulation anomalies likely represent climatic cycles rather than systematic over-simulation (Mantua and Hare, 2002).
5.4 Peak Flows

Predicted increases in the magnitude and frequency of peak flow events, and a shift in the timing, are logical consequences of forecasted increases in winter precipitation and temperatures. Higher precipitation values alone would increase the magnitudes of floods in the early winter months due to more rain and a lack of a well-developed snowpack to attenuate the runoff. Currently, the flood risk declines later in the winter season because the area contributing to runoff shrinks and the snowpack reaches a threshold thickness (P. Cooper, personal communication, 2010). However, with increases in both winter precipitation and temperatures, histograms of peak flow events illustrate that the season of high flood risk is likely to last longer into the winter. Additionally, warmer winter temperatures during the development of the snowpack may lead to more rain-on-snow events and thus higher peak flow events.

Increasing trends in the frequency and magnitude of floods are supported by my modeling results, but the absolute magnitudes of such events are questionable, especially during the summer months. The comparison of the simulated and observed time series and distributions of annual maxima provides validation that the model is accurately simulating some peak flows. However, both the historic and future simulations show peak flow events above 30,000 cfs occurring in the summer months, which are not observed at the Ferndale gauge (Figure 38). In particular, two peaks over 30,000 cfs were simulated in July of 1972 and 1997 due to unusually large summer rainfall events. These July events were measured at Ferndale at 19,100 and 15,300 cfs, respectively. This exaggeration may be due to the temporally constant precipitation lapse rate that I used to calibrate the model. Although the relatively high lapse rate I chose adequately satisfied winter weather, it may be too high and
over simulate rainfall at higher altitudes in the summer. I failed to recognize this during the
calibration phase because the calibration period did not contain major summer rainfall events.
To examine this more fully, I also compared the top 200 peak flows at Ferndale with the
same events simulated at Cedarville for the entire year and for July through October. There
is a lot of scatter in both cases; however, a tendency toward over-simulation of the late
summer/early fall events is evident (Figure 39).

The magnitudes of winter peak flow events are also difficult to predict due to the lack
of accurate high flow observations in the historical record and the uncertainties associated
with the forecasted datasets. Peak discharge measurements are made with lower confidence
because above a certain threshold, a rating curve is used to predict discharge based on gauge
height, rather than a direct measurement. Therefore, my calibration of the DHSVM
emphasized the existence and timing of peaks in the simulated hydrograph over the
magnitude of those peaks. The simulation of peak flows is subject to the same increasing
uncertainty through time as the overall simulations due to the increasing uncertainty of the
GCMs. Additionally, the simulations are forced by disaggregated daily data, with daily
precipitation values divided evenly into eight 3-hour time steps. Therefore, high-intensity
precipitation events may be muted in the forecast data, which would affect the magnitude of
floods. Although future high flow events are of particular concern for water resources
planning, predictions of peak flows should be treated with caution and used as a guide of
trend rather than of magnitude.
5.5 Other Factors

Future streamflow in the Nooksack River may be affected by a number of other factors that are not accounted for in this study, including changes in land use, vegetation, geomorphic features, and population through time. Neither the effects of increasing urbanization, nor the effects of building roads in the watershed are considered in this model; the spatial characteristics of the basin remain static through the fifty year simulations. Changes in precipitation and weather patterns may affect the frequency and magnitude of landslides and subsequent sediment loads in the Nooksack River. Increasing temperatures coupled with a growing population will likely increase water demand for irrigation, consumption, and recreation. With summer flows predicted to decrease, and with the drought season predicted to lengthen, the compounding effects of higher demand with lower availability are an important consideration for water resource planning. Groundwater recharge and usage will also be affected by a changing climate (e.g., Scibek and Allen, 2006). As summer droughts worsen, user demand for water resources may be in competition with compliance for required in-stream flows. The effects of reduced summer flows along with reduced glacial contribution to streamflow may also include changes to water temperature and water quality which could adversely affect municipal drinking water and fluvial habitat.
6.0 Conclusion

This study predicts the range and central tendency of the response of streamflow and snowpack in the Nooksack River basin to global climate change. My modeling results forecast that median streamflow, flows at both extremes, and the timing of streamflow will shift through time. Median winter streamflow is predicted to increase and summer streamflow is predicted to decrease. Intensification of low summer flows caused by reductions in glacial extent is expected. As the spring melt peak shifts earlier in the year and its magnitude is moderated by decreases in SWE, the spring hydrograph peak will coalesce with the winter peak. Although much uncertainty is associated with the simulation of peak flows, the general trend of increasing magnitudes of annual and spring peak flows, and of increasing frequency of floods are supported by these data.

The magnitude of hydrologic changes in the Nooksack River basin depends on the magnitude and direction of change in future temperature and precipitation, which will be partly controlled by future anthropogenic emissions. In the absence of one correct forecast of future climate, a range of forecasts were used in order to provide a spectrum of probable responses of the Nooksack River to climate change. These simulations do not provide an upper and lower limit, but do indicate the magnitude of change to streamflow and snowpack in response to what is currently considered the high and low ends of possible future climate scenarios.

A complete understanding of the sensitivity of the Nooksack River to climatic changes is critical to future water resources in Whatcom County. In order to plan for adaptation to future water availability we must anticipate both the extremes and central
tendencies of future streamflow and SWE. Some of the initial effects of climate change to
streamflow in the Nooksack River are likely already occurring, and we can expect to
continue to see a changing hydrograph through time. Simulation of future streamflow and
SWE in the Nooksack River under a range of climate forecasts makes it clear that the entire
distribution of streamflow will shift as the climate, and particularly temperature, changes.
This study provides a framework within which local water resources planning can occur
without the underlying assumption that past events dictate the probability of future events.
7.0 References


National Climate Data and Information Archive (NCDIA; 2009), Environment Canada, http://climate.weatheroffice.ec.gc.ca


World Climate Research Programme (WCRP). 2009. LLNL-Reclamation-SCU downscaled climate projections derived from the WCRP's CMIP3 multi-model dataset, stored and served at the LLNL Green Data Oasis, Statistically Downscaled WCRP CMIP3 Climate Projections, http://gdo-dcp.ucnl.org/downscaled_cmip3_projections/dcpInterface.html#Welcome
8.0 Tables

Table 1. Calibrated parameters of the DHSVM for the Nooksack River basin.

<table>
<thead>
<tr>
<th>Parameter</th>
<th>Value(s)</th>
<th>Units</th>
</tr>
</thead>
<tbody>
<tr>
<td>Grid Spacing</td>
<td>150</td>
<td>m</td>
</tr>
<tr>
<td>Time Step</td>
<td>3</td>
<td>hr</td>
</tr>
<tr>
<td>Temperature Lapse Rate</td>
<td>Oct: -0.0065, Nov-Mar: -0.0062, Apr-May: -0.0075, Jun: -0.0080, Jul-Aug: -0.0090, Sep: -0.0065</td>
<td>°C/m</td>
</tr>
<tr>
<td>Precipitation Lapse Rate</td>
<td>0.001</td>
<td>m/m</td>
</tr>
<tr>
<td>Snow Threshold Temperature</td>
<td>0</td>
<td>°C</td>
</tr>
<tr>
<td>Rain Threshold Temperature</td>
<td>0</td>
<td>°C</td>
</tr>
<tr>
<td>Soil Depth Range</td>
<td>0.76 - 3.50</td>
<td>m</td>
</tr>
<tr>
<td>Lateral Hydraulic Conductivity of Soil Types 3, 4, and 6</td>
<td>0.001</td>
<td>m/s</td>
</tr>
<tr>
<td>Maximum Infiltration of Soil Types 3 and 4</td>
<td>$3 \times 10^{-5}$</td>
<td>m/s</td>
</tr>
<tr>
<td>Maximum Infiltration of Soil Type 6</td>
<td>$1 \times 10^{-5}$</td>
<td>m/s</td>
</tr>
<tr>
<td>Porosity of three layers of Soil Type 3</td>
<td>0.50, 0.50, 0.50</td>
<td></td>
</tr>
<tr>
<td>Porosity of three layers of Soil Type 4</td>
<td>0.56, 0.56, 0.56</td>
<td></td>
</tr>
<tr>
<td>Porosity of three layers of Soil Type 6</td>
<td>0.53, 0.53, 0.53</td>
<td></td>
</tr>
</tbody>
</table>

Table 2. Changes (°C) in monthly mean temperature for the three downscaled forecasts relative to Abbotsford (1950-1999; Spring = March, April, May; Summer = June, July, August; Autumn = September, October, November; Winter = December, January, February). Note that the forecasts consist of a fifty-year time series that has been shifted based on the statistics of the 31-year period centered on the year of the forecast (i.e., 2000 is characterized by the climate of 1985-2015).

<table>
<thead>
<tr>
<th></th>
<th>GISS_B1</th>
<th>Echam_A2</th>
<th>IPSL_A2</th>
<th>Mean of Three Models</th>
</tr>
</thead>
<tbody>
<tr>
<td></td>
<td>Spring</td>
<td>Summer</td>
<td>Autumn</td>
<td>Winter</td>
</tr>
<tr>
<td>2000</td>
<td>0.8</td>
<td>1.3</td>
<td>0.6</td>
<td>1.0</td>
</tr>
<tr>
<td>2025</td>
<td>1.5</td>
<td>2.0</td>
<td>1.2</td>
<td>1.3</td>
</tr>
<tr>
<td>2050</td>
<td>1.8</td>
<td>2.5</td>
<td>1.7</td>
<td>1.3</td>
</tr>
<tr>
<td>2075</td>
<td>1.8</td>
<td>2.8</td>
<td>1.9</td>
<td>1.9</td>
</tr>
</tbody>
</table>
Table 3. Changes (mm) in monthly total precipitation for the three downscaled forecasts relative to Abbotsford (1950-1999; Spring = March, April, May; Summer = June, July, August; Autumn = September, October, November; Winter = December, January, February). Note that the forecasts consist of a fifty-year time series that has been shifted based on the statistics of the 31-year period centered on the year of the forecast (i.e., 2000 is characterized by the climate of 1985-2015).

<table>
<thead>
<tr>
<th></th>
<th>GISS_B1</th>
<th></th>
<th></th>
<th></th>
<th>Echam_A2</th>
<th></th>
<th></th>
<th></th>
</tr>
</thead>
<tbody>
<tr>
<td></td>
<td>Spring</td>
<td>Summer</td>
<td>Autumn</td>
<td>Winter</td>
<td>Spring</td>
<td>Summer</td>
<td>Autumn</td>
<td>Winter</td>
</tr>
<tr>
<td>2000</td>
<td>13</td>
<td>3</td>
<td>34</td>
<td>27</td>
<td>17</td>
<td>4</td>
<td>23</td>
<td>27</td>
</tr>
<tr>
<td>2025</td>
<td>20</td>
<td>0</td>
<td>37</td>
<td>21</td>
<td>16</td>
<td>16</td>
<td>26</td>
<td>22</td>
</tr>
<tr>
<td>2050</td>
<td>16</td>
<td>-8</td>
<td>39</td>
<td>13</td>
<td>29</td>
<td>6</td>
<td>23</td>
<td>30</td>
</tr>
<tr>
<td>2075</td>
<td>28</td>
<td>-7</td>
<td>26</td>
<td>21</td>
<td>20</td>
<td>8</td>
<td>28</td>
<td>52</td>
</tr>
</tbody>
</table>

<table>
<thead>
<tr>
<th></th>
<th>IPSL_A2</th>
<th></th>
<th></th>
<th></th>
<th>Mean of Three Models</th>
<th></th>
<th></th>
<th></th>
</tr>
</thead>
<tbody>
<tr>
<td></td>
<td>Spring</td>
<td>Summer</td>
<td>Autumn</td>
<td>Winter</td>
<td>Spring</td>
<td>Summer</td>
<td>Autumn</td>
<td>Winter</td>
</tr>
<tr>
<td>2000</td>
<td>17</td>
<td>5</td>
<td>27</td>
<td>24</td>
<td>16</td>
<td>4</td>
<td>28</td>
<td>26</td>
</tr>
<tr>
<td>2025</td>
<td>7</td>
<td>11</td>
<td>35</td>
<td>37</td>
<td>14</td>
<td>9</td>
<td>33</td>
<td>27</td>
</tr>
<tr>
<td>2050</td>
<td>20</td>
<td>-2</td>
<td>28</td>
<td>42</td>
<td>22</td>
<td>-1</td>
<td>30</td>
<td>28</td>
</tr>
<tr>
<td>2075</td>
<td>25</td>
<td>0</td>
<td>30</td>
<td>75</td>
<td>25</td>
<td>0</td>
<td>28</td>
<td>49</td>
</tr>
</tbody>
</table>

Table 4. Percent change in median seasonal streamflow simulated using three GCM-based forecasts for the periods centered on 2000, 2025, 2050, and 2075, relative to the historic simulation (1950-1999) of streamflow (Spring = March, April, May; Summer = June, July, August; Autumn = September, October, November; Winter = December, January, February). Note that the forecasts consist of a fifty-year time series that has been shifted based on the statistics of the 31-year period centered on the year of the forecast (i.e., 2000 is characterized by the climate of 1985-2015).

<table>
<thead>
<tr>
<th></th>
<th>GISS_B1</th>
<th></th>
<th></th>
<th></th>
<th>Echam_A2</th>
<th></th>
<th></th>
<th></th>
</tr>
</thead>
<tbody>
<tr>
<td></td>
<td>Spring</td>
<td>Summer</td>
<td>Autumn</td>
<td>Winter</td>
<td>Spring</td>
<td>Summer</td>
<td>Autumn</td>
<td>Winter</td>
</tr>
<tr>
<td>2000</td>
<td>18%</td>
<td>0%</td>
<td>30%</td>
<td>42%</td>
<td>24%</td>
<td>9%</td>
<td>14%</td>
<td>22%</td>
</tr>
<tr>
<td>2025</td>
<td>35%</td>
<td>-18%</td>
<td>28%</td>
<td>41%</td>
<td>22%</td>
<td>-10%</td>
<td>30%</td>
<td>49%</td>
</tr>
<tr>
<td>2050</td>
<td>28%</td>
<td>-26%</td>
<td>35%</td>
<td>40%</td>
<td>33%</td>
<td>-21%</td>
<td>23%</td>
<td>65%</td>
</tr>
<tr>
<td>2075</td>
<td>36%</td>
<td>-28%</td>
<td>9%</td>
<td>42%</td>
<td>23%</td>
<td>-47%</td>
<td>18%</td>
<td>121%</td>
</tr>
</tbody>
</table>

<table>
<thead>
<tr>
<th></th>
<th>IPSL_A2</th>
<th></th>
<th></th>
<th></th>
<th>Mean of Three Models</th>
<th></th>
<th></th>
<th></th>
</tr>
</thead>
<tbody>
<tr>
<td></td>
<td>Spring</td>
<td>Summer</td>
<td>Autumn</td>
<td>Winter</td>
<td>Spring</td>
<td>Summer</td>
<td>Autumn</td>
<td>Winter</td>
</tr>
<tr>
<td>2000</td>
<td>26%</td>
<td>-1%</td>
<td>18%</td>
<td>28%</td>
<td>23%</td>
<td>3%</td>
<td>21%</td>
<td>30%</td>
</tr>
<tr>
<td>2025</td>
<td>19%</td>
<td>-9%</td>
<td>28%</td>
<td>57%</td>
<td>25%</td>
<td>-13%</td>
<td>28%</td>
<td>49%</td>
</tr>
<tr>
<td>2050</td>
<td>38%</td>
<td>-33%</td>
<td>7%</td>
<td>77%</td>
<td>33%</td>
<td>-27%</td>
<td>22%</td>
<td>61%</td>
</tr>
<tr>
<td>2075</td>
<td>38%</td>
<td>-45%</td>
<td>-5%</td>
<td>127%</td>
<td>32%</td>
<td>-40%</td>
<td>7%</td>
<td>97%</td>
</tr>
</tbody>
</table>
9.0 Figures

Figure 1. Hillshade map of the Nooksack River watershed with inset location map of the watershed within Washington State. The locations of USGS stream gauges at Ferndale (F) and North Cedarville (C) are indicated by red squares; Abbotsford (AB) meteorological station by a red circle; and SNOTEL stations at Wells Creek (WC), Middle Fork (MF), and Elbow Lake (EL) by red triangles.
Figure 2. 2040s change in temperature and precipitation for the Pacific Northwest, as predicted by twenty GCM-emissions scenario couples; the three representative couples used by the CCTC, and in this study, are in boxes (Mote and others, 2005).
Figure 3. Example of an empirical cumulative distribution function (eCDF) for April mean monthly temperature from 1950-1999, using frequency as a proxy for non-exceedance probability. The blue dashed line indicates the median of the distribution, with a non-exceedance probability of 0.5.

Figure 4. Empirical cumulative distribution functions of April mean temperature from 1950-1999 for regional gridded data and for local data from the Abbotsford station. The blue line indicates the difference in temperature ($\Delta T$) between two values with the same non-exceedance probability.
Figure 5. Empirical cumulative distribution functions for April mean temperature for 1950-1999 at the Abbotsford station, and for 2035-2065 of the bias-corrected forecast.

Figure 6. The historical distribution of mean temperature is shifted to create the 2050s forecast by applying the $\Delta T$ indicated by the distribution for the 2035-2065 forecast data.
**Figure 7.** Hydrograph of observed and simulated streamflow at the North Cedarville USGS gauging station for water years (WY) 2006 through 2009, the four year period used for calibration and validation.

**Figure 8.** Hydrograph of observed streamflow at the Ferndale USGS gauging station and simulated streamflow at the Cedarville station for WY 2001 through 2005.
Figure 9. Observed and simulated snow water equivalent (SWE) at three SNOTEL stations in the Nooksack basin for WY 2006 through 2009, the four year period used for calibration and validation.
Figure 10. Observed and simulated SWE at three SNOTEL stations in the Nooksack basin for the length of their observational record, which varies by station.
Figure 11. Boxplots of monthly temperature and precipitation values for the Abbotsford station and for the downscaled hindcasts for 1950-1999. The distributions of fifty years of monthly data are represented by the boxplots: the horizontal line is the median, the box extends to the 25th-75th percentiles, the whiskers extend to the minimum and maximum, or 1.5 times the interquartile range, and the dots are outliers.
Figure 12. Empirical cumulative distribution functions for monthly mean temperature for the Abbotsford station and the downscaled time series for 1950-1999.
Figure 13. Empirical cumulative distribution functions for total monthly precipitation for the Abbotsford station and for the downscaled time series for 1950-1999.
Figure 14. Boxplots of fifty years of monthly mean temperature for Abbotsford and for three downscaled forecasts under 2000 (top) and 2025 (bottom) climate conditions.
Figure 15. Boxplots of fifty years of monthly mean temperature for Abbotsford and for three downscaled forecasts under 2050 (top) and 2075 (bottom) climate conditions.
Figure 16. Empirical cumulative distribution functions for monthly mean temperature for Abbotsford and for the three downscaled forecasts under 2000, 2025, 2050, and 2075 climate conditions.
Figure 17. Boxplots of fifty years of total monthly precipitation for Abbotsford and for three downscaled forecasts under 2000 (top) and 2025 (bottom) climate conditions.
Figure 18. Boxplots of fifty years of total monthly precipitation for Abbotsford and for three downscaled forecasts under 2050 (top) and 2075 (bottom) climate conditions.
Figure 19. Empirical cumulative distribution functions for total monthly precipitation for Abbotsford and for three downscaled forecasts under 2000, 2025, 2050, and 2075 climate conditions.
Figure 20. Monthly mean SWE at the Middle Fork SNOTEL station for the historical simulation (1950-1999) and for simulations of 2000, 2025, 2050, and 2075 climate conditions using forecasts downscaled from the GISS_B1 (top), the Echam_A2 (center), and the IPSL_A2 (bottom) GCMs.
Figure 21. Monthly mean SWE at the Middle Fork SNOTEL station for the historical simulation (1950-1999) and for simulations of 2000, 2025, 2050, and 2075 climate conditions using forecasts downscaled from the GISS_B1 (top), the Echam_A2 (center), and the IPSL_A2 (bottom) GCMs. Note that each boxplot includes fifty years of monthly mean values.
Figure 22. Monthly mean SWE at the Wells Creek (North Fork) SNOTEL station for the historical simulation (1950-1999) and for simulations of 2000, 2025, 2050, and 2075 climate conditions using forecasts downscaled from the GISS_B1 (top), the Echam_A2 (center), and the IPSL_A2 (bottom) GCMs.
Figure 23. Monthly mean SWE at the Wells Creek (North Fork) SNOTEL station for the historical simulation (1950-1999) and for simulations of 2000, 2025, 2050, and 2075 climate conditions using forecasts downscaled from the GISS_B1 (top), the Echam_A2 (center), and the IPSL_A2 (bottom) GCMs. Note that each boxplot includes fifty years of monthly mean values.
Figure 24. Monthly mean SWE at the Elbow Lake (South Fork) SNOTEL station for the historical simulation (1950-1999) and for simulations of 2000, 2025, 2050, and 2075 climate conditions using forecasts downscaled from the GISS_B1 (top), the Echam_A2 (center), and the IPSL_A2 (bottom) GCMs.
Figure 25. Monthly mean SWE at the Elbow Lake (South Fork) SNOTEL station for the historical simulation (1950-1999) and for simulations of 2000, 2025, 2050, and 2075 climate conditions using forecasts downscaled from the GISS_B1 (top), the Echam_A2 (center), and the IPSL_A2 (bottom) GCMs. Note that each boxplot includes fifty years of monthly mean values.
Figure 26. Monthly median streamflow at the North Cedarville USGS station for the historical simulation (1950-1999) and for simulations of 2000, 2025, 2050, and 2075 climate conditions using forecasts downscaled from the GISS_B1 (top), the Echam_A2 (center), and the IPSL_A2 (bottom) GCMs.
Figure 27. Boxplots of monthly median streamflow at the North Cedarville USGS station for the historical simulation (1950-1999) and for simulations of 2000, 2025, 2050, and 2075 climate conditions using forecasts downscaled from the GISS_B1 (top), the Echam_A2 (center), and the IPSL_A2 (bottom) GCMs. Note that each simulation period includes fifty years of data.
Figure 28. Monthly mean SWE at a glacier-covered pixel at 2005 m elevation for the historical simulation (1950-1999) and the GISS_B1 simulations of 2000, 2025, 2050, and 2075.

Figure 29. A time series of annual peak flows observed at the Ferndale station and simulated at the Cedarville station for WY 1951-1999.
Figure 30. Boxplots of annual peak flows for WY 1951-1999 for the observed peaks at Ferndale and the simulated peaks at Cedarville, and the simulated peaks under 2000, 2025, 2050, and 2075 climate conditions using downscaled forecasts from the GISS_B1 (top), the Echam_A2 (center), and the IPSL_A2 (bottom) GCMs.
Figure 31. Empirical cumulative distribution functions of annual peak flows for the historical simulation and for the Ferndale gauging station (upper left), and for the historical simulation and each GCM-based forecast.
Figure 32. Empirical cumulative distribution functions of spring peak flows for the historical simulation and each GCM-based forecast.
Simulated Peaks Above 30,000 cfs

Simulated Peaks Above 40,000 cfs

Simulated Peaks Above 50,000 cfs

Figure 33. Frequency of peaks over 30,000, 40,000, and 50,000 cfs for the 2000, 2025, 2050, and 2075 simulations.
Figure 34. Histograms of peak flows above 30,000 cfs simulated with each forecast dataset.
Figure 35. Boxplots of monthly mean temperature for 1950-1999 and 1985-2009 at the Abbotsford station, and for the three forecast datasets centered on 2000.
Figure 36. Hydrographs of monthly median streamflow with 2001 glacier coverage, and with glacier coverage reclassified as shrub (i.e., no glaciers) for three GCM-based forecasts and five simulation periods.
Figure 37. Time series of mean SWE at the Middle Fork SNOTEL for the historical simulation (1950-1999). Note that each boxplot includes each monthly mean SWE value for the entire year for a total of twelve values represented in each plot.

Figure 38. Histogram of peak flows above 30,000 cfs at Ferndale (observed) from 1966-1999, and at Cedarville (simulated) from 1950-1999.
Figure 39. Top 200 daily flows at Ferndale (observed) from 1966-1999, and at Cedarville (simulated) for the same days for the entire year (top) and for July-October only (bottom).
Appendix A. DHSVM Set-up

Much of this text was taken directly from a similar appendix in Carrie Donnell’s Master’s Thesis (2007); the instructions have been modified with minor corrections and my additional notes.  SED

1. CREATE A DEM GRID


2. Download and unzip Digital Elevation Models (DEM)s.
I used the following twenty-three 10 meter DEMs in Washington State in order to fully encompass the Nooksack River basin:

I downloaded them from:
http://duff.geology.washington.edu/data/raster/tenmeter/

The projection of the DEMs are UTM, Zone 10, datum NAD 27, and units in meters. All the final grids will be in this projection.

3. Convert DEM files to raster files.
Open ArcMap → Arc Toolbox → Conversion Tools → To Raster → DEM to Raster
Input USGS DEM file: deming.dem
Output raster: U:/ThesisGIS2/dems/deming → OK

This will convert the DEM to a raster, and import the raster to ArcMap. All DEMs have to be converted to raster files individually.

4. Mosaic DEMs.
a. Access the Spatial Analyst toolbar: View/Toolbars/Spatial Analyst
Set analysis environment
From Spatial Analyst dropdown menu → Options
Or Right click in toolbox to set environments
Under Extent tab, Analysis extent: Union of Inputs
Under Cell size tab, Analysis cell size: Maximum of Inputs → OK

b. Mosaic the DEMs using Raster Calculator (or alternate method)
Open Spatial Analyst toolbar → raster calculator
Create the Mosaic expression in the text box:
<Nooksackdem>=mosaic ([deming], [CanyonLake], [etc.])

→Evaluate (this takes a long time)

b2. Alternate method: use the ‘Mosaic to new raster’ tool
Open ArcToolbox → Data Management tools → Mosaic to new raster
→ Environments
Under general tab, Working directory: U:/ThesisGIS2/dems
   Under Extent tab, Analysis extent: Union of Inputs
   Under Cell size tab, Analysis cell size: Maximum of Inputs

c. Once DEMs are mosaic-ed, locate the new DEM in ArcCatalog and drag it into ArcMap.

5. Resample DEMs to 150 m by 150 m pixel resolution.
a. Set analysis environment (very important)
Open ArcToolbox → Data Management tools → Raster → Resample → environment
Under General Settings tab:
   Current Workspace: U:/ThesisGIS2/dems
   Scratch Workspace: U:/ThesisGIS2/dems
   Output coordinate system: Same as layer “Nooksackdem”
   Output Extent: Same as layer “Nooksackdem”
Under Raster Analysis settings tab:
   Cell size: 150
   Mask: None
   → OK

b. Resample:
   Input Raster: “Nooksackdem”
   Output Raster: “dem150” (suggests an .img file extension, which I deleted)
   Cell size: 150
   Resampling Technique: Nearest
   → OK

Once the mosaic-ed raster is resampled to 150m resolution, Nooksackdem (10 m resolution) can be removed from ArcMap.

2. CREATE A WATERSHED MASK
1. Create another folder within the workspace. I titled mine “setup”.

2. Fill sinks to even out the DEM.
Open hydrology/models toolbar → Fill Sinks
Input surface: dem150
Fill limit: <Fill_All>
Output raster: U:/ThesisGIS2/setup/fillsinks
→ OK (This takes a long time)

3. Perform flow direction on the filled DEM.
This grid is necessary for determining the watershed boundary.
Open hydrology/models toolbar→Flow direction
Input surface: fillsinks
Output raster: U:/ThesisGIS2/setup/flowdir
→OK

4. Perform flow accumulation.
This grid is also necessary for determining the watershed boundary.
Open hydrology/models toolbar→Flow accumulation
Direction raster: flowdir
Output raster: U:/ThesisGIS2/setup/flowacc
→OK

5. Set interactive properties to create a watershed boundary.
Open hydrology modeling toolbar→Interactive properties
Flow direction: flowdir
Flow accumulation: flowacc
→OK

6. Create the watershed boundary and mask.
Click the watershed button from the hydrology modeling toolbar.

This is an interactive tool which will determine the boundary of the watershed based on the destination cell. I selected the point downstream of the North Cedarville USGS gauging station and ArcGIS determined which cells would eventually drain water to that point. I had to repeat the process a few times before I was satisfied with the watershed boundary.

When a watershed is created, it is a temporary file. Make it permanent, right-click on the watershed grid in ArcMap table of contents→Make Permanent→set source to the current workspace (U:/ThesisGIS2/setup/nf). This raster file will be used as the “mask” input for DHSVM.

Eventually I settled on using the entire Nooksack Basin as a single watershed. I tried a number of different combinations of watersheds (e.g. modeling the three forks and the confluence separately, modeling the South Fork separately and everything else together). The Erase Tool in ArcMap was essential for creating these combinations:

Open ArcToolbox→Analysis Tools→Overlay→Erase

The Erase tool allows the user to erase one polygon from another (e.g. the South Fork from the whole watershed); in order to use this tool the raster files must be converted to polygons:

Open ArcToolbox→Conversion Tools→From Raster→Raster to Polygon
Be sure to uncheck the “Simplify polygons” box.
The modified polygons can then be converted to rasters to create the masks for clipping and for use with DHSVM.

Open ArcToolbox→Conversion Tools→To Raster→Polygon to Raster

7. Once the watershed mask is created, it can be used to clip the DEM and hillshade (optional) to the watershed. The polygon of the watershed can also be used to clip other grids to the watershed, but be careful that the polygon was not simplified, because the final mask needs to have the same number of rows and columns as each of the clipped coverages.

Open ArcToolbox→Spatial Analyst Tools→Extraction→Extract by Mask

Input raster: U:/ThesisGIS2/dem/dem150
Input raster or feature mask data: nook
Output raster: U:/ThesisGIS2/setup/nookdem→OK

Alternatively, you can use the raster calculator for this step (or any extraction step).

8. Extract a clipped DEM with filled sinks. This will be needed for running the AML (see below).

Open ArcToolbox→Spatial Analyst Tools→Extraction→Extract by Mask

Input raster: U:/ThesisGIS2/setup/fillsinks
Input raster or feature mask data: nook
Output raster: U:/ThesisGIS2/setup/nookdemf→OK

I used an f at the end of a dem name to indicate that it is filled, and an flt to indicate that it had been converted to floating point (see below).

3. CREATE A LANDCOVER GRID


I downloaded the coverage for the entire west coast.

The landcover file is already an ESRI grid, so it does not need to be converted. The PCS may be different than that for the DEM, but ArcGIS should be able to project the grid on the fly.

2. Resample grid to 150 by 150 m resolution.

Open ArcToolbox→Data management Tools→Raster→Resample

Set the analysis environment (very important):

Under General Settings tab:

Current Workspace: (U:/ThesisGIS2/setup)
Scratch Workspace (U:/ThesisGIS2/setup)
Output coordinate system: Same as layer “nookdem”
Output Extent: Same as layer “nookdem”
Under Raster Analysis settings tab:
   Cell size: 150
Mask: None
→OK to close environments setting

Input raster: landcover
Output raster: landcover150
Output cell size: 150
Resampling technique: nearest neighbor
→OK

3. **Clip landcover grid to watershed boundary.**

Open ArcToolbox→Spatial Analyst Tools→Extraction→Extract by Mask
→Environment
Working directory: U:/ThesisGIS2/setup
Analysis mask: nook
Extent: nook
Cellsize: 150
→OK

Input raster: U:/ThesisGIS2/setup/landcover150
Input raster or feature mask data: nook
Output raster: U:/ThesisGIS2/setup/nookveg
→OK

4. **Reclassify NOAA vegetation classifications to DHSVM classifications.**

Open ArcToolbox→Spatial Analyst→Reclass→Reclassify
Set general and raster analysis environments
Input Raster: nookveg
Output Raster: reclassveg
Reclass Field: Value
Then:
NOAA Landcover classifications are different from the landcover classifications in DHSVM. Read the Coastal NLCD Classification Scheme and match land cover types with vegetation descriptions in the DHSVM configuration file as closely as possible. I used the following values for the reclassification:

<table>
<thead>
<tr>
<th>NOAA</th>
<th>NOAA description</th>
<th>DHSVM</th>
<th>DHSVM description</th>
</tr>
</thead>
<tbody>
<tr>
<td>2</td>
<td>High Intensity Developed</td>
<td>13</td>
<td>Urban</td>
</tr>
<tr>
<td>3</td>
<td>Medium Intensity Developed</td>
<td>13</td>
<td>Urban</td>
</tr>
<tr>
<td>4</td>
<td>Low Intensity Developed</td>
<td>13</td>
<td>Urban</td>
</tr>
<tr>
<td>5</td>
<td>Developed Open Space</td>
<td>12</td>
<td>Bare</td>
</tr>
</tbody>
</table>
5. **Create alternate landcover grids with reduced or no glacier coverage.**

To create a landcover grid with no glacier coverage I reclassified all of the vegetation type 20 (Glacier) pixels as vegetation type 9 (Open Shrub):

Open ArcToolbox→Spatial Analyst→Reclass→Reclassify
Set general and raster analysis environments
Input Raster: reclassveg
Output Raster: nookshrub
Reclass Field: Value

To create reduced glacier coverage grids (this method is a long way around; there must be an easier way):

Extract vegetation type 20 by attribute
Convert to polygon
Choose Start Editing from the pull down menu, and use edit tools to select and delete some pixels.
Save edits when finished.
Convert to raster
Reclassify all pixels to a type of vegetation that does not exist, e.g. 21.
In the Spatial Analyst toolbar, choose Options, and Extent to set extent to the original vegetation layer.
Use Raster Calculator to merge the reclassified raster with the original landcover grid
nookveg25=merge({glac25},{nooksackveg})

Reclassify vegetation type 20 (Glacier) as type 9 (Open Shrub)
Reclassify vegetation type 21 (new glacier extent) as type 20 (Glacier)
4. CREATE A SOIL TEXTURE GRID

Donnell (2007) used the following steps:

1. **Download soil texture coverage** from STATSGO for Whatcom County, WA from http://www.essc.psu.edu/soil_info/etc/statsgolist.cgi?statename=Washington
   I created a new folder within C:/MFdhsvm called soils. Save the file (wa.e00) in this file.

2. **Convert file.** This is a GIS export file that has to be converted in ArcCatalog.
   Open ArcCatalog→Conversion Tools→Import from Interchange File
   Input file: C:\MFdhsvm\soil\wa.e00\wa.e00
   Output dataset: C:\MFdhsvm\soil\wa
   The file will now appear in ArcCatalog and can be dragged into ArcMap. The PCS may be different than that for the DEM, but ArcGIS should be able to project the grid on the fly.

3. **Convert soil polygon to raster.**
   Open ArcToolbox→Conversion Tools→To Raster→Feature to Raster
   Set analysis environments by clicking on the Environments button
   Under General Settings tab:
   Current Workspace: (C:/MFdhsvm/soils)
   Scratch Workspace (C:/MFdhsvm/soils)
   Output coordinate system: Same as layer “Nooksackdem”
   Output Extent: Same as layer “Nooksackdem”
   Under Raster Analysis settings tab:
   Cell size: 50
   Mask: None
   OK to close environments setting
   Input features: wa polygon
   Field: MUID
   Output raster: C:\MFdhsvm\soil\wa.e00\wa\soilgrid
   Output cell size: 50
   →OK

Remove wa polygon from ArcMap

4. **Clip soil grid to watershed.**
   Set analysis environment:
   Click Spatial Analysts toolbar→Options
   Working directory: C:/MFdhsvm/soils
   Analysis mask: watershedpoly
   Extent: watershedpoly
   Cellsize: 50
From Spatial Analyst dropdown menu→raster calculator
Type the expression: soilshed=soilgrid
→Evaluate

Soil classifications are as follows:

<table>
<thead>
<tr>
<th>MUID</th>
<th>Description</th>
<th>MUID</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>1*</td>
<td>Sand</td>
<td>10</td>
<td>Sandy Clay</td>
</tr>
<tr>
<td>2</td>
<td>Loamy Sand</td>
<td>11</td>
<td>Silty Clay</td>
</tr>
<tr>
<td>3*</td>
<td>Sandy Loam</td>
<td>12</td>
<td>Clay</td>
</tr>
<tr>
<td>4</td>
<td>Silty Loam</td>
<td>13</td>
<td>Organic (as loam)</td>
</tr>
<tr>
<td>5*</td>
<td>Silt</td>
<td>14*</td>
<td>Water (as clay)</td>
</tr>
<tr>
<td>6*</td>
<td>Loam</td>
<td>15*</td>
<td>Bedrock</td>
</tr>
<tr>
<td>7</td>
<td>Sandy Clay Loam</td>
<td>16</td>
<td>Other (as SCL)</td>
</tr>
<tr>
<td>8*</td>
<td>Silty Clay Loam</td>
<td>17</td>
<td>Muck</td>
</tr>
<tr>
<td>9</td>
<td>Clay Loam</td>
<td>18</td>
<td>Talus</td>
</tr>
</tbody>
</table>

* Soil classifications in the Middle Fork Nooksack basin

**Dickerson (2010) notes the following problems and possible solutions:**
Although the hydrology of the Nooksack River basin is not likely to be highly sensitive to soil types due to relatively shallow soil depths on steep, mountainous slopes, I found a few problems with the above methodology, and chose to use a soil type dataset derived specifically for hydrology modeling. First, the association of the map unit identification (MUID) with the “value” is eliminated during the clipping process. The MUID numbers in the table, above, are actually value numbers. To retain the MUID, you must use “Joins and Relates” to join the two attribute tables based on Value. The MUID is the link to all information in the STATSGO database including the comp table and the layer table (which are included in the download of the wa.e00 file). Each map unit has up to 21 components with no spatial resolution (e.g. 24% of a map unit is one soil composition, but there is no spatial information about the distribution), and each component can have up to 7 layers, all of which are linked in attribute tables via the MUID (USDA/NRCS, 2001). The classification scheme, above, which relates a Value to a Soil Type appears to be from the Wiley and Clancy Washington soil dataset that I use, described below, rather than a direct usage of the STATSGO database. In applying the above classification scheme to the STATSGO data and then comparing the soil types to the Wiley and Clancy data for the same area, there were conflicting soil type classifications. Information about STATSGO is available at: [http://www.nrcs.usda.gov/technical/techtools/statsgo_db.pdf](http://www.nrcs.usda.gov/technical/techtools/statsgo_db.pdf)
An alternate method could be to use the surface texture (“SURTEX”) characteristic associated with each map unit, or to use the dominant texture grid from the CONUS database on the STATSGO website: [http://www.soilinfo.psu.edu/index.cgi?soil_data&conus&data_cov&texture&datasets&geo](http://www.soilinfo.psu.edu/index.cgi?soil_data&conus&data_cov&texture&datasets&geo) (the CONUS coverage is a large file (10 Mb) because it covers the entire United States).
I chose instead to use the soil coverage (wasoil_150) created by Matt Wiley and Erin Clancy for use with DHSVM at 150 m resolution (Wiley, personal communication, 2009); the same coverage was used by the Climate Change Technical Committee for the study after which I am modeling this research. Wiley and Clancy combined the STATSGO soil type, modeled soil depth, and surficial geology data to create a soils grid for Washington state (Wiley, personal communication, 2009).

6. CREATE SOIL DEPTH AND STREAM NETWORK GRIDS
I created the soil depth and stream network grids using Arc (Arc is a command line version of ArcGIS, and accessible through the ArcInfo Workstation menu options).

To get to Arc:  Start->ArcGIS->ArcInfo Workstation->Arc (command line prompt pops up)
Helpful Arc commands:
(more available from “ArcDoc” accessed through the ArcInfo workstation):
workspace       lists current workspace
listgrids       lists grids in current workspace
quit (or q)     leave grid session and back to Arc prompt, or end Arc session

1. Reclassify the watershed mask (e.g. nook).
The watershed mask values must be defined as inbasin=1 and outside basin=NODATA. Otherwise the AML will create a stream network for the entire raster. You can check the values in ArcMap by opening the DEM properties dialogue.

Open ArcToolbox→Spatial Analyst Tools→Reclassify→Reclassify
Input raster: U:/ThesisGIS2/setup/nook
inbasin=1 and NODATA (outside basin)=NODATA
Output polygon features: U:/ThesisGIS2/setup/Reclass_nook
→OK

After the mask has been reclassified, it cannot be used to extract by mask anymore – the extraction will extract the entire square (including the former NO DATA area). So I went into ArcCatalog and renamed nook as “nook_raster” (not reclassified), and Reclass_nook as “nook_mask” which is reclassified.

2. Create a workspace.
Create a new folder:  C:/Susan_dhsvm/nook/streams

The AML only works for me when I run it directly from the hard drive rather than a networked drive or an external hard drive. Also, there is much discussion on the DHSVM archive about the finicky nature of the createstreamnetwork aml; tips gleaned from that website include: close ArcCatalog and ArcMap before running the AML (so that the needed files are not open or being accessed), and always begin with a new, completely empty folder.
for each AML run so that you do not inadvertently carry over files that were created during the previous run of the AML.

Obtain the AML scripts from Bob Mitchell or the DHSVM tutorial online (http://www.hydro.washington.edu/Lettenmaier/Models/DHSVM/index.shtml) (To do this, download tutorial.tar.gz (save, not open), Find the file in the windows folder; double click, “I agree” when winzip pops up, select all and “extract”; AML scripts are in the arcinfo folder that is created by extracting the files.)

In ArcCatalog: Copy the reclassified mask, the filled, clipped dem (nookdemf) and amlscripts from the DHSVM tutorial into the “streams” folder.

Check the computer to ensure that it has a Java Runtime Environment (JRE). If it doesn’t, download Java software from www.sun.com.

To check for JRE, open Arc and type:
Arc: &sys java –version
If the JRE is installed, you should get:
Java version “1.6.0_11” (I used 1.4.2_05, on Bob Mitchell’s lab computer)
Java [TM] SE Runtime Environment, Standard Edition (build 1.6.0_11-b03)
Java HotSpot[TM] Client VM (build11.0-b16, mixed mode, sharing).

3. Check file paths for AML.
If you are using a folder that is titled something aside from “streams”, make sure to change the filepath for AddAat2.class within the createstreamnetwork AML, before running the AML.

The scripted is coded to look in the streams folder, so if this step is skipped, the AML will encounter an error, but will continue to run anyway. It will produce zeros within the streamnetwork.dat for slope, segorder, etc. and DHSVM cannot use this file.

To change the filepath, open the AML as a text file (e.g., using Wordpad) and use the ‘find’ tool (find “AddAat.2”) to locate the path and changed the path to your soildep folder instead:
&sys java -classpath ../soildep/amlscripts/AddAat2 %streamnet%

4. Convert filled dem to floating point and run the AML
Open ARC. Type:
ARC: &workspace C:/Susan_dhsvm/nook/streams
ARC: grid
GRID: nookdemflt = FLOAT(nookdemf)
GRID: q
ARC: &watch aml.watch
ARC: &amlpath C:/Susan_dhsvm/nook/streams /amlscripts
ARC: &run createstreamnetwork nookdemflt nook_mask nooksoildep1 nookstreams1 MASK 220000 0.76 1.5
Where ‘nookdemflt’ is the clipped, filled dem coverted to floating point; ‘nookdemf’ is the clipped, filled dem; ‘nook_mask’ is the reclassified raster mask; ‘nooksoildep1’ and ‘nookstreams1’ are the names I chose for output files.

The last three numbers are variables representing the minimum contributing area before a channel begins, the minimum soil depth, and maximum soil depth (in meters). I used a 1 at the end of each of the output files to distinguish them from future files, when the AML is run again with different soil depths (e.g. nooksoildep2 may range from 0.76 to 2.5 m).

This process takes a long time (approximately 45 min for my 366x430 pixel grid). Just before the script finishes running it will ask you if you want to continue. Answer ‘y’ for yes, and it will finish the process.

Output from this step includes: soil depth raster (nooksoildep), a stream network feature class, stream.map.dat, and stream.network.dat (note that the two .dat files only appear when the folder is viewed with Windows, not in ArcCatalog. Open stream.network.dat with Wordpad to check whether the AML has run properly; if it has, there will be a variety of numbers in the last two columns rather than all zeros.

I ran this step multiple times – for each basin that I created and then changing the soil depth for calibration of the model. Each time I renamed the “streams” folder (e.g., to streams_1.5), and then created a new stream folder by copying in the needed inputs. This is because the program will overwrite the files that are named the same way every time the AML is run (e.g., stream.network.dat)

7. CREATE A SERIES OF SHADING MAPS

1. Create a workspace.
Create a new folder: C:/Susan_dhsvm/northfork/shadow

Copy the clipped dem and watershed mask into this folder using ArcCatalog.

The solar AML (process_solar or process_solar1) and 3 “C” files, make_dhsvm_shade_maps.exe, skyview.exe, and average_shadow.exe are available from Robert Mitchell; they are not available in the amlscripts folder in the DHSVM tutorial. Carrie Donnell compiled these using the ‘lcc’ compiler in the Computer Science department with the help of Matt Paskus. Copy the amlscripts folder with the aml, and the .exe files into the ‘shadow’ folder. Note that the three .exe files should be in the shadow folder directly, rather than in the amlscripts folder.

2. Run the AML
Arc: &workspace C:/Susan_dhsvm/northfork/shadow
Arc: &watch aml.watch
Arc: &amlpath C:/Susan_dhsvm/northfork/shadow/amlscripts
Arc: &r process_solar nook nookdem 3 0.0
Arc: q
The watershed mask is nook, and the dem is nookdem. The last two numbers represent the model timestep (I used 3 hours) and GMT offset, respectively. Robert Mitchell’s previous DHSVM set-up instructions have noted that Matt Wiley (formerly of UW, currently of 3Tier in Seattle) usually uses 0 as the GMT offset; it’s a little confusing, in that the time stamp on the model runs is then off by 8 hours, for example the warmest part of the day is at 8:00 pm, but that works better when using daily data with the met record creation programs, and avoids the confusion of daylight savings time, times zones etc.

At the end of the session Arc will state that the AML command “rm” is not recognized in Windows; however, it produced the needed output (which are 12 shadow maps and a skyview file, all of which are .bin files and will not be visible in ArcCatalog). Transfer the shadow maps to Horton, and rename each file (ex: ‘Shadow.01.hourly.bin’ is renamed ‘shadow.01.bin’).

8. CONVERT DEM, SOIL TYPE, SOIL THICKNESS, VEGETATION, AND WATERSHED FILES TO ASCII GRIDS

I created a new file for each conversion and copied the GIS grid to be converted into the file. I then convert all the NoData values in the grids to something that DSHVM recognizes (e.g., water=14) and converted the grids to ascii format.

For DEM, Soil Type, Soil Thickness, and Vegetation:

Example:
For the nooksack DEM, Type:
Arc: &workspace U:\ThesisGIS2\setup
Arc: grid
GRID: nookdem.asci = gridascii(con(isnull(nookdem),14,nookdem))

Repeat for all dem, soil type, soil thickness, and vegetation grids.

GRID: q
ARC: q

NOTES:
- the term before the equal sign is the new file name; the “.asci” is just to remind me that it is an ascii file.
- there is no space between & and workspace
- there is a space on either side of the equal sign, the function will not work if you have a space in the wrong place.
- the new file will not appear in Arc Catalog, but a “projection” file will be created along with it that ArcCatalog will see; the new file can be viewed in Windows via “My Computer”.

109
For the Mask:
Use the re-classified watershed raster. Use 0 rather than 14 for the no data values

GRID: nook_mask.asci = gridascii(con(isnull(nook_mask),0,nook_mask))

9. TRANSFER ASCII GRIDS FROM A P.C. TO A UNIX SYSTEM
All of the ascii files need to be transferred to Horton, the Unix system in Robert Mitchell’s laboratory. The transfer requires a secure shell (e.g. WinSCP or SSH); the address for Horton is:

horton.geol.wwu.edu

Transfer the ascii files to the Input directory. Additionally, transfer stream.network.dat and stream.map.dat (stream.network.dat and stream.map.dat were created by the aml in Step #6), the twelve shadow maps, skyview file, and the meteorological input file to the Input directory.

10. CONVERT ASCII GRIDS TO BINARY (on Horton)
Open the ascii Files using EMACS (a UNIX word processing program), and read/record first six lines (# of rows, columns, etc.), and then delete them. The files can also remain in your PC workspace for future reference of the first six lines. Check that each ascii file has the same number of rows and columns – a difference in the size of the grids will prevent DHSVM from running.

Convert the ascii gids (e.g. nookdem.asci) to binary files using “myconvert” (a program available from Robert Mitchell) in the Input directory.

The correct variable type for each grid is:

- **mask, landcover, soil type**: uchar
- **dem, soil depth**: float

Example (for mask, land cover, soil type):

horton > ./myconvert ascii uchar nookmask.asc nookmask.bin 366 430

Example (for dem, soil depth):

horton > ./myconvert ascii float nookdem.asc nookdem.bin 366 430

Where:

horton> ./myconvert source_format target_format source_file target_file number_of_rows number_of_columns

11. CREATE A FINAL STREAM MAP AND STREAM NETWORK FILE
Use the program “assign” (a program available from Robert Mitchell) to create a final stream map and stream network. stream-net.dat and stream-map.dat are the final map and network files.

Example:

horton>./assign stream.network.dat stream.map.dat stream-net.dat stream-map.dat

I used the hyphen to indicate that the file that has been “assigned”.

12. LOCATE THE STREAM GAUGE FOR DHSVM CALIBRATION.
The stream gauge location in DHSVM is based on the location of the end of a stream segment generated in the stream network aml, not the actual location of the gauge. Open ArcMap and add the stream network Arc to the map if needed. Locate the position of the stream gauge using the coordinate indicators in the lower right corner of the screen, or plot the location of the stream gauge using “Tools” and “add X Y data”. The output segment is the segment that terminates the closest to the stream gauge location. Stream discharge is not at a pixel, it is at the end of a selected stream segment. After the stream gauge is located, click on the stream segment nearest the gauge using the “INFO” button to determine the stream segment ID #. Record the segment number/value. On Horton, open the final stream network file using EMACS, and type ‘SAVE’ next to the appropriate stream segment.

Then, copy the final stream files (stream-net.dat and stream-map.dat) into the state directory.

13. LOCATE THE PIXELS FOR SWE OBSERVATIONS.
Determine coordinates for pixel dumps that will be used for SWE calibration. Exact locations of SNOTEL stations are available by contacting NRCS (the locations on the website are intentionally vague). Use ArcMap to locate the pixel, and check the elevation, aspect, and land cover for that location. If necessary, move the SNOTEL location to a pixel that has the correct characteristics, or reclassify the pixel. For example, for accurate simulation of SWE the pixel must not have over-story vegetation (i.e., it should be classified as urban, bare, or grassland).

14. SET INITIAL CONDITIONS FOR DHSVM CALIBRATION
1. Create initial channel state files:
   In the State Directory, type:
   horton> awk ‘{print $1, 0.1}’ stream-net.dat> Channel.State.09.30.2005.23.00.00

   The Channel.State file should be named for the day and last time step before the water year you will simulate (09.30.2005.23.00.00 for simulating WY 2006).

2. Create model state files
   First:
Edit InitialState.txt (available from Bob, or from the dshvm tutorial): change the starting date (e.g. 9-30-05-23 for running a simulation of water year 2006, which begins on 10/1/05), and the number of rows and columns in the grids (previously deleted from the ascii files).

Then:
Run the MakeModelStateBin program with the following syntax:

```
horton> ./MakeModelStateBin InitialState.txt
```

This creates the initial Interception, Snow, and Soil state files for the date that is specified in the InitialState.txt file. The date indicates the beginning of the model simulation.

15. SET UP INPUT FILE
Edit the DHSVM configuration file using EMACS, including specifications for: start and end dates and times, UTM coordinates for extreme NW corner of mask, pixel size, names of binary inputs (e.g., soil, soil depth; note that file names are case sensitive), location of meteorological station, location of pixel dumps (e.g., SNOTEL stations), soil parameters, temperature and precipitation lapse rates, and other parameters.

16. RUN THE MODEL
From the main directory (horton/dickers/dhsvm/nooksack/nook>)

```
horton> DHSVM input.nook  (note: DHSVM command is case sensitive)
or
horton> time DHSVM input.nook
```

Where DHSVM is the command, and input.nook is the configuration file (a text file); the addition of “time” to the beginning of the command will print the elapsed time at the end of the simulation.

Another useful command is:
```
horton> nohup DHSVM input.nook &
```

This will allow DHSVM to run in the background without terminating when you “hang up” the connection by logging off Horton or powering off your remote PC.

17. RE-RUN THE MODEL with NEW INITIAL CONDITIONS
Create initial conditions using the steps above, run the model for a year or more (the “spin-up” period), and then use the output conditions from the first simulation as the initial conditions to re-run the model for the same year. To do this, copy the output states (in the Output directory) to the State directory and rename them to be consistent with the first date and hour of the next simulation.
Appendix B. Example R Code for Downscaling

I completed the downscaling steps using the open source statistical program R (R Development Core Team, 2008; http://www.r-project.org/). Writing scripts and functions allowed me to automate many steps of downscaling and data analysis, which involved manipulating large dataframes (larger than the bounds of what Excel will import). Below is an example of a control file and an example of the downscaling function. These functions are presented in order to document my downscaling methodology, but the cumbersome nature of this code reflects my status as a novice R programmer.

**Control File**

A master control file for each desired final dataset (e.g. GISS 2000) calls variables and functions from other files.

```
########################################################################
# Source File for Downscaling 1/8 degree Met Data
# Created by S.Dickerson, August 2009
# Source Code for calling other functions and downscaling GISS 2000
#
# R
########################################################################

# First - Get the Data
# source the historical data (local and regional)
# via the file dailytomonthly_only.r
# which loads and aggregates the data to Monthly

source("U:/Thesis/Downscaling/R Code/dailytomonthly_only.r")

# Read in GISS monthly temperature data, 1950-2099

gisT = read.table("U:/Thesis/DownScaling/GISS_B1/Tavg.csv", F, sep=",")

colnames(gisT)<- c("Year","Month","Mean.Temp")

# Source the functions for downscaling temperature

source("U:/Thesis/Downscaling/R Code/downscaletemp_function.r")

source("U:/Thesis/Downscaling/R Code/downscaletemp_function_FEBRUARY.r")

# MEAN TEMP
# List of arguments

local<-abbT
#objects abbT, abb, mauT are defined within dailytomonthly_only.r
```
daily<-abb
reg<-mauT
fore<-gisT
yr<-2000

Jan<- downscaletemp(local,daily,reg,fore,M=1,n=31,yr)
Feb<- downscaletempPEB(local,daily,reg,fore,M=2,yr)
#note different function!
Mar<- downscaletemp(local,daily,reg,fore,M=3,n=31,yr)
Apr<- downscaletemp(local,daily,reg,fore,M=4,n=30,yr)
May<- downscaletemp(local,daily,reg,fore,M=5,n=31,yr)
Jun<- downscaletemp(local,daily,reg,fore,M=6,n=30,yr)
Jul<- downscaletemp(local,daily,reg,fore,M=7,n=31,yr)
Aug<- downscaletemp(local,daily,reg,fore,M=8,n=31,yr)
Sep<- downscaletemp(local,daily,reg,fore,M=9,n=30,yr)
Oct<- downscaletemp(local,daily,reg,fore,M=10,n=31,yr)
Nov<- downscaletemp(local,daily,reg,fore,M=11,n=30,yr)
Dec<- downscaletemp(local,daily,reg,fore,M=12,n=31,yr)

one<-as.data.frame(rbind(Jan,Feb,Mar,Apr,May,Jun,Jul,Aug,Sep,Oct,Nov,Dec))
colnames(one)<-c("Year","Month","Day","newminT","newmaxT")
giss2000T<-one[order(one$Year,one$Month),]

########## this would be followed by similar steps for precipitation
########## see GISS2000.r

########## End of temperature portion of control file
###########################################################

Example Downscaling Function

Downscaling temperature for every month except February:

###################################################################
# Source File for Downscaling 1/8 degree Met Data
# Created by S.Dickerson, August 2009
# R
###################################################################

###################################################################
# Master function - run all the sub-functions

114
# Output: 50 years of downscaled data for one month
# and one variable (temperature)

downscaletemp <- function(local,daily,reg,fore,M,n,yr){

#################################################################
# List of arguments
# local=local MONTHLY dataset (1950-1999)
# daily=local DAILY dataset (1950-1999)
# reg=regional MONTHLY gridded dataset (1950-1999)
# fore=regional MONTHLY forecast dataset (1950-2099)
# M=month (e.g. Jan = 1)
# n=number of days in month (needed as input for function #3)
# yr=Year of interest, for centering of 31-year slice of forecast

#################################################################
# Function 1 - Plotting position
# Inputs:  dataframe of monthly data (argument), Month (argument)
# Goals: Subset data, calculate plotting position (Wiebull),
# column-bind to dataframe
# Output:  Dataframe with Year, Month, Mean Temp, and plotting position

pp <- function(x,M){
onemonth<-subset(x,Month==M)
temp<-onemonth$Mean.Temp
len.x =length(temp)
weibull<-rank(temp,ties.method="random")(len.x+1)
foo<-data.frame(onemonth,weibull)
#plot(weibull~temp) #optional plotting command
foo
}

#here I'm running Function 1 internally
localC <- pp(local,M)
regC <- pp(reg,M)
foreC <- pp(fore,M)

############## Plot (this is optional, okay to remove)
#Compare the regional and local ecdfs with the forecast data
plot(localC$Mean.Temp,localC$weibull, col='blue',xlab='Mean Temp (deg C)',ylab='Weibull Plotting Position',main='ECDFs for local, regional, and forecast met data', xlim=c(-10,10) )
points(regC$Mean.Temp, regC$weibull,col='red')
points(foreC$Mean.Temp,foreC$weibull, col='green')
legend(x="topleft", c("Abbotsford, 1950-1999 (Local)", "Maurer, 1950-1999 (Regional)", "GISS, 1950-2099 (Forecast)"), fill = c("blue","red","green"),bty="n" )

115
# Function 2 - Make Local to Regional Quantile Map
# Inputs: complete local and regional dataframes
# (output from function #1)
# Goals: Order dataframes by plotting position,
# calculate dT (local minus regional, b/c then I'll apply it to
# go from regional back to local)
# Output: Dataframe with dT and plotting position

```r
qmap <- function(q, r) {
  q.pp <- q[order(q$weibull),]
  r.pp <- r[order(r$weibull),]
  dT <- q.pp$Mean.Temp - r.pp$Mean.Temp
  map <- cbind(q.pp$weibull, dT)
  colnames(map) <- c("weibull", "dT")
  map
}
```

# define the arguments and run the function internally:

```r
q <- localC
r <- regC
abb.let.map <- as.data.frame(qmap(q, r))
```

# Function 3 -
# Bias-Correct Forecast Data with Local to Regional Quantile Map
# Inputs: dataframe of local/regional quantile map
# (output from function #2), complete dataframe of forecast data
# (output from function #1)
# Goals: Interpolate quantile map to lengthen to 150 years,
# apply dT (regional plus dT) to get bias-corrected forecast data.
# Output: Dataframe with Year, Month, and bias-corrected forecast data.
# (note: don't need to retain plotting position because it is
# recalculated from 31-year slice later on)

```r
bc <- function(s, t) {
  u <- t[order(t$weibull),]
  s.spl <- as.data.frame(spline(s, xout = u$weibull, method = "natural"))
  # extrapolate beyond calculated dT values, could change this with xmin or
  # xmax statement
  # I chose spline method=natural because it seemed more conservative - #fmm
  # extrapolated a long way from the last datapoint (but along the #same
  # slope), natural was a little closer, and "period" flipped in the #other
  # direction.

  colnames(s.spl) <- c("weibull", "dT")

  ##Here's a plotting statement to help remember how the spline works.
  #plot(s, type = "b")
  #lines(s.spl, col = "red")
  #points(s.spl, col = "green")
```
bc.temp<-u$Mean.Temp+s.spl$dT
foo<-as.data.frame(cbind(u$Year,u$Month,bc.temp))
#no reason to keep the other data in the dataframe at this point
colnames(foo)<-c("Year","Month","bc.Temp")
bc.forecast<-foo[order(foo$Year),]
bc.forecast

#define the arguments and run the function internally:
s <- abb.let.map
t <- foreC
foreBC<-bc(s,t)

#plot(foreBC$bc.Temp, col="green")  #optional plotting statments
#points(foreC$Mean.Temp, col="red")


###########################################################
# Function 4 -
# Map 31-year slice of Bias-Corrected Regional Forecast Data onto 50-year historical Dataset (create quasi-steady state time series)
# Inputs:  bias-corrected regional forecast data (output from # function #3), year that the slice is centered on (argument),
# 50 years of one month of local data with plotting position
# (output from function #1)
# Goals: Select 31-year slice of forecast, Calculate eCDF, interpolate
# between temperatures to expand the length to 50 years, calculate dT
# between two datasets
#{Subtract: regional Forecast - Local = difference to apply to daily
#local
# Output:  Dataframe with Year, Month, and dT (to apply to daily data)
slice <- function(foreBC,yr,localC){
  min <- yr-16
  max <- yr+16
  oneslice <- subset(foreBC,Year>min & Year<max)
  temp <-oneslice$bc.Temp
  len.x = length(temp)
  weibull <-rank(temp,ties.method="random"){len.x+1}
  foo <-data.frame(oneslice,weibull)
  bar <-foo[order(foo$weibull),]
  #plot(bar$bc.Temp,bar$weibull)  #optional plot command
  localO<-localC[order(localC$weibull),]
  bar.spl<- as.data.frame(spline(bar$weibull,bar$bc.Temp,
  xout=localO$weibull, method="natural"))
  colnames(bar.spl) <- c("weibull","bc.Temp")
  dT <- bar.spl$bc.Temp-localO$Mean.Temp
  fee <- cbind(localO,dT)
  fi <- fee[order(fee$Year),]
  foe <- rep(1950:1999,each=n)
  fooey <- rep(M,length(foe))
  flap <- rep(fi$dT,each=n)
  fum <- cbind(foe, fooey, flap)
  colnames(fum) <- c("Year","Month","dT")
```R
fum
}

daily.dT<-as.data.frame(slice(foreBC,yr,localC))

# Function 5 -
# Apply monthly dT values to BOTH Min and Max temps
# in the daily time series
# Inputs: Month (argument),
# daily.dT(output from function #4), daily abbotsford data (argument)
# Goals: Subset daily time series by month, Add dT to daily time series
# Output: Dataframe with Year, Month, Day and bias corrected met values

cb.daily <- function(daily,M){
  onemonth<-subset(daily,Month==M)
  minT<-onemonth$Min.Temp
  newminT<-minT+daily.dT$dT
  maxT<-onemonth$Max.Temp
  newmaxT<-maxT+daily.dT$dT
  foo<-cbind(onemonth$Year, onemonth$Month,onemonth$Day,newminT,newmaxT)
  foo
}

abb.dailyBC <- cb.daily(daily,M)  #could easily output more variables here

abb.dailyBC
}

###End of Function

Known Variations in Downscaling Methodology

Through the process of interpreting and trying to pattern my methodology after that
of previous studies, variations were created due to my lack of understanding and my mistakes.
These variations are presented here for consideration in future work.

First, I completed downscaling as one step rather than downscaling 1950-1999 and
2000-2099 as two separate datasets and then concatenating them. Additionally I used a
natural spline to lengthen my entire datasets rather than fitting the tails to an extreme value
distribution as is suggested in some literature. Analysis of boxplots of daily and monthly
distributions of precipitation indicated that the historical range of precipitation is generally
represented by at least one of the three forecasts, and, therefore, that there is no consistent
bias in the forecasted extreme values for precipitation. Lastly, I found one mistake that did
not affect my data, but exists nonetheless: NA values for every day in July 1960. This
mistake was due to my downscaling function (specifically, function #2 within the
downscaling function), in which the data sets are ordered by weibull plotting position. Then,
the local total precipitation is divided by the regional total precipitation for the same potting
position. In the case of the lowest non-exceedance probability, both values are zero, which
equals infinity, and therefore yielded a NaN. Lastly, when NaN is multiplied by the daily
```
values, all of which are then NaN values. This mistake did not affect my simulations, however, because the disaggregation script automatically converted the NaN values to zeroes, which is what they should have been. Both the local and the regional historic weather data for July 1960 have zero precipitation recorded for the month, and, thus, the forecast for July 1960 should be zero.
Appendix C. Deliverables to Funding Agencies

The final products of this project are local, downscaled GCM-based climate change forecasts, a calibrated and validated DHSVM for the upper Nooksack River basin, and simulations of the watershed hydrology of the Nooksack River basin under future climate conditions. Simulations include four periods in the 21st century, centered on 2000, 2025, 2050, and 2075. Additionally, a baseline simulation using the unadjusted 50-year Abbotsford time series is provided for reference, and for comparison to historical streamflow and snow water equivalent (SWE) observations. The downscaled climate forecasts provide a range of predictions for future climate in Whatcom County. These forecasts are available for use in future simulations of local hydrology, and other natural processes that will be affected by climate change. The upland portion of the Nooksack River basin is set-up and calibrated in DHSVM for future studies on the hydrology of the basin. The largest source of uncertainty in this study arises from the GCM forecasts and their associated emissions scenarios. The GCMs will become more sophisticated as the computing power to run the models efficiently at finer resolutions becomes possible, reducing the need to parameterize some processes. Additionally, emissions scenarios will evolve to reflect current conditions and predictions of future political, economical, and technological factors. As new GCM forecasts become available the same historical weather dataset can be used in the downscaling process for use in updating streamflow predictions for the Nooksack River.

Each streamflow simulation encompasses the thirty-one year average of climate for a specific time in the future, and the local variability encompassed by fifty years of historical weather data. Additionally, each simulation period include three simulations based on
different GCM-emissions scenario couples, thus representing a range of possibilities that bracket some of the possible variability of future streamflow. Both the average prediction and the range of predictions are potentially useful in assessing the impacts of climate change on future water resources in Whatcom County.